MOBILE AUGMENTED REALITY

Membangun Aplikasi Augmented Reality
Berbasis Android

Miftah Andriansyah - Antonius Irianto Sukowati
Hadi Rahmadi - Muhammad Subali
Debyo Saptono - Imam Purwanto

Penerbit Gunadarma



MOBILE AUGMENTED REALITY

Membangun Aplikasi Augmented Reality
Berbasis Android

Miftah Andriansyah - Antonius Irianto Sukowati
Hadi Rahmadi - Muhammad Subali
Debyo Saptono - Imam Purwanto

Penerbitan buku ini didukung oleh Hibah Penelitian Dosen
Pemula dengan sumber pendanaan dari Direktorat Riset dan
Pengabdian Masyarakat, Direktorat Jenderal Penguatan Riset
dan Pengembangan, Kementerian Riset, Teknologi, dan
Pendidikan Tinggi Republik Indonesia

Penerbit Gunadarma



MOBILE AUGMENTED REALITY
Membangun Aplikasi Augmented Reality Berbasis Android

Penulis :

e Miftah Andriansyah

e Antonius Irianto Sukowati
e Hadi Rahmadi

e Muhammad Subali

e Debyo Saptono

e Imam Purwanto

Cetakan Pertama, September 2018

Desain Cover : Aprian Karisman

Diterbitkan pertama kali oleh Gunadarma

JI. Margonda Raya No. 100, Pondokcina, Depok 16242
Telp. +62-21-78881112, 7863819 Fax. +62-21-7872829
e-mail : sektor@gunadarma.ac.id

ISBN : 978-602-9438-96-3
Hak Cipta dilindungi undang-undang. Dilarang mengutip atau

memperbanyak dalam bentuk apapun sebagian atau seluruh isi
buku tanpa ijin tertulis dari penerbit.

ISBN 978-b02-9438-9k-

786029 " 438963




Prakata

Bismillahir rahmaanir rahiim,

Dengan mengucap puji dan syukur ke hadirat Allah SWT atas
berkat dan karunia-NYA yang diberikan, hingga terselesaikan pe-
nyusunan buku Mobile Augmented Reality ini. Seiring dengan per-
kembangan zaman khususnya di bidang teknologi selalu terdapat
inovasi terbaru salah satunya adalah teknologi Augmented Reality
yang patut untuk dirangkum dan diulas secara ringkas dan jelas.

Buku Mobile Augmented Reality ini dimaksudkan untuk ma-
syarakat luas agar memahami teknologi Augmented Reality yang
sedang berkembang saat ini, karena masih sedikitnya panduan da-
lam membuat dan mengembangkan aplikasi Augmented Reality
baik dalam bentuk buku, artikel, maupun pelatihan. Semua mate-
ri pembahasan dalam buku ini disajikan dengan penjelasan yang
cukup jelas dan mudah dipahami, selain pembahasan materi ter-
dapat tutorial dengan tujuan pembaca mampu mengimplementa-
sikan dalam membuat aplikasi Augmented Reality.

Penulis dapat menyelesaikan buku ini atas arahan dan dorong-
an dari banyak pihak. Untuk itu penulis menyampaikan terima-
kasih kepada semua pihak yang telah memberikan arahan tentang
isi cakupan buku ini. Kepada pihak yang juga telah memberikan
dukungan dalam berbagai bentuk, penulis sampaikan rasa terima
kasih yang sebanyak-banyaknya.

Saran dan kritik yang bersifat membangun demi kesempurna-
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an buku ini penulis terima dengan tangan terbuka. Semoga buku
ini dapat bermanfaat bagi kita. Terima kasih telah membaca dan

menggunakan buku ini.

Tangerang, September 2018
Penulis




Ringkasan

Augmented Reality atau dalam bahasa Indonesia disebut realitas
tambah adalah sebuah istilah dari lingkungan yang menggabungk-
an antara dunia nyata dengan dunia virtual. Augmented Reality
merupakan teknologi baru yang berkembang cepat khususnya pa-
da perangkat mobile Android. Buku merupakan media pembela-
jaran agar dapat mengetahui inforimasi, ilmu dasar, dan sebagai
pedoman dalam belajar.

Panduan dasar ini mengadaptasi teknologi Augmented Reali-
ty yang diterapkan pada perangkat mobile berbasis Android. Pan-
duan pada buku ini yaitu membuat aplikasi yang dapat menam-
pilkan animasi 3 Dimensi serta pelengkap informasi lainnya. Ter-
dapat informasi tambahan untuk memperoleh penjelasan meng-
enai materi yang terdapat pada buku ini. Aplikasi ini dibangun
dengan menggunakan software Unity, Vuforia SDK (Software De-
velopment Kit), dan beberapa software tambahan yang diperlukan
untuk membuat aplikasi Augmented Reality yang ada pada materi.

Dengan adanya Buku Augmented Reality ini diharapkan dapat
bermanfaat sebagai media pembelajaran dan mempermudah cara
membuat aplikasi Augmented Reality.

Augmented Reality atau dalam bahasa Indonesia disebut rea-
litas tambah adalah sebuabh istilah dari lingkungan yang mengga-
bungkan antara dunia nyata dengan dunia virtual. Augmented Re-
ality merupakan teknologi baru yang berkembang cepat khusus-
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nya pada perangkat mobile Android. Buku merupakan media pem-
belajaran agar dapat mengetahui inforimasi, ilmu dasar, dan seba-
gai pedoman dalam belajar.

Panduan dasar ini mengadaptasi teknologi Augmented Reali-
ty yang diterapkan pada perangkat mobile berbasis Android. Pan-
duan pada buku ini yaitu membuat aplikasi yang dapat menam-
pilkan animasi 3 Dimensi serta pelengkap informasi lainnya. Ter-
dapat informasi tambahan untuk memperoleh penjelasan meng-
enai materi yang terdapat pada buku ini. Aplikasi ini dibangun
dengan menggunakan software Unity, Vuforia SDK (Software De-
velopment Kit), dan beberapa software tambahan yang diperlukan
untuk membuat aplikasi Augmented Reality yang ada pada materi.

Dengan adanya Buku Augmented Reality ini diharapkan dapat
bermanfaat sebagai media pembelajaran dan mempermudah cara
membuat aplikasi Augmented Reality.

Buku merupakan media pembelajaran agar dapat mengetahui
inforimasi, ilmu dasar, dan sebagai pedoman dalam mempelajari
Augmented Reallity yang diterapkan pada perangkat mobile ber-
basis Android. Panduan pada buku ini yaitu membuat aplikasi yang
dapat menampilkan animasi 3 Dimensi serta pelengkap informasi
lainnya. Aplikasi augmented reality pada buku ini dibangun de-
ngan menggunakan software Unity, Vuforia SDK (Software Deve-
lopment Kit), dan beberapa software tambahan yang diperlukan
untuk membuat aplikasi Augmented Reality.

Augmented Reality atau dalam bahasa Indonesia disebut rea-
litas tambah adalah sebuah istilah dari lingkungan yang mengga-
bungkan antara dunia nyata dengan dunia virtual. Augmented Re-
ality merupakan teknologi baru yang berkembang cepat khusus-
nya pada perangkat mobile Android. Buku merupakan media pem-
belajaran agar dapat mengetahui inforimasi, ilmu dasar, dan seba-
gai pedoman dalam belajar.
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Bab 1

Pendahuluan

1.1 Augmented Reality

Augmented Reality atau dalam bahasa indonesia dise-
but Realitas Tambah adalah teknologi yang menggabungk-
an benda maya dua dimensi dan ataupun tiga dimen-

si ke dalam sebuah lingkungan nyata tiga dimensi la-
lu memproyeksikan benda-benda maya tersebut dalam
waktu nyata. Tidak seperti realitas maya yang sepenuh-
nya menggantikan kenyataan, realitas tertambah seka-
dar menambahkan atau melengkapi kenyataan.

Augmented Reality adalah sebagai penggabungan benda-
benda nyata dan maya di lingkungan nyata, berjalan se-
cara interaktif dalam waktu nyata, dan terdapat inte-
grasi antarbenda dalam tiga dimensi, yaitu benda maya
terintegrasi dalam dunia nyata. Penggabungan benda
nyata dan maya dimungkinkan dengan teknologi tam-
pilan yang sesuai, interaktivitas dimungkinkan melalui
perangkat-perangkat input tertentu, dan integrasi yang
baik memerlukan penjejakan yang efektif. (Ronald T.
Azuma, 1997)

Ronald Azuma pada tahun 1997 mendefinisikan Augmen-
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Pendahuluan

ted Reality sebagai sistem yang memiliki karakteristik
sebagai berikut: (Ronald T. Azuma, 1997)

Menggabungkan lingkungan nyata dan virtual.
Berjalan secara interaktif dalam waktu nyata.

Integrasi dalam tiga dimensi (3D).

Tujuan dari Augmented Reality adalah mengambil du-
nia nyata sebagai dasar dengan menggabungkan bebe-
rapa teknologi virtual dan menambahkan data konstek-
tual agar pemahaman manusia sebagai penggunanya men-
jadi semakin jelas. Data konstektual ini dapat berupa
komentar audio, data lokasi, konteks sejarah, atau da-
lam bentuk lainnya. Pada saat ini, Augmented Reality
telah banyak digunakan dalam berbagai bidang seper-
ti kedokteran, militer, manufaktur, hiburan, museum,
game pendidikan, pendidikan, dan lain-lain. (Rahmat,
2011)

Salah satu contoh penerapan Augmented Reality dalam
pendidikan yaitu aplikasi Augmented Reality pengenal-
an hewan-hewan secara dini kepada anak sangat ber-
manfaat dengan tujuan agar anak mampu mengenal ben-
tuk dan nama hewan, yang secara tidak langsung me-
numbuhkan kecintaan dan kepedulian terhadap ling-
kungan tempat tinggal hewan-hewan yang berdamping-
an dengan manusia.

Dengan memanfaatkan teknologi Augmented Reality, ca-
ra pengenalan hewan dapat lebih menyenangkan dan
mempermudah pemahaman anak karena informasi atau
objek yang ditampilkan terlihat lebih nyata dalam ben-
tuk 3D.
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Gambar 1.1: Contoh Augmented Reality Pengenalan Hewan

1.2 Prinsip Kerja Augmented Reality

Sistem Augmented Reality bekerja berdasarkan deteksi
citra, dan citra yang digunakan adalah marker. Prinsip
kerjanya sebenarnya cukup sederhana. Camera yang
telah dikalibrasi akan mendeteksi marker yang diberik-
an, kemudian setelah mengenali dan menandai pola mar-
ker, webcam akan melakukan perhitungan apakah mar-
ker sesuai dengan database yang dimiliki. Bila tidak,
maka informasi marker tidak akan diolah, tetapi bila se-
suai maka informasi marker akan digunakan untuk me-
render dan menampilkan objek 3D atau animasi yang
telah dibuat sebelumnya.

1.3 Perkembangan Augmented Reality

Dalam perkembangannya Augmented Reality telah di-
gunakan pada beberapa bidang kehidupan. Bidang-bidang
yang telah menggunakan Augmented Reality antara la-

in:
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. Kedokteran (Medical)

Teknologi pencitraan sangat dibutuhkan di dunia
kedokteran, seperti misanya, untuk simulasi ope-
rasi, simulasi pembuatan vaksin virus, dll. Untuk
itu, bidang kedokteran menerapkan Augmented Re-
ality pada visualisasi penelitian mereka.

. Hiburan (Entertainment)

Dunia hiburan membutuhkan Augmented Reality
sebagai penunjang efek-efek yang akan dihasilkan
oleh hiburan tersebut. Sebagai contoh, aplikasi Au-
gmented Reality berbasis game yang saat ini sedang
booming yaitu Pokemon Go.

. Latihan Militer (Military Training)

Militer telah menerapkan augmented reality pada
latihan tempur mereka. Sebagai contoh, militer meng-
gunakan Augmented Reality untuk membuat sebu-

ah permainan perang, dimana prajurit akan masuk
kedalam dunia game tersebut, dan seolah-olah se-
perti melakukan perang sesungguhnya.

. Engineering Design

Seorang engineering design membutuhkan Augmen-
ted Reality untuk menampilkan hasil design mere-
ka secara nyata terhadap klien. Dengan Augmen-
ted Reality klien akan tahu, tentang spesifikasi yang
lebih detail tentang desain mereka.

. Consumer Design

Augmented Reality telah digunakan dalam memp-
romosikan produk. Sebagai contoh, seorang pe-
ngembang menggunkan brosur virtual untuk mem-
berikan informasi yang lengkap secara 3D, sehing-
ga pelanggan dapat mengetahui secara jelas, pro-
duk yang ditawarkan.(Andriyadi, 2011)
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Pendahuluan

1.4 Perangkat Augmented Reality

Perangkat AR Perangkat AR dapat dikategorikan menjadi lima je-
nis yaitu: Optical See-Through, Virtual Retinal Systems, Video See-
Through, Monitor Based AR dan Projector Based AR.

1. Optical See-Through

Optical See-Through merupakan perangkat yang dipasang di-
kepala untuk menampilkan objek virtual di dunia nyata. Per-
angkat ini memiliki kaca optik di depan mata pengguna.

2. Virtual Retinal Systems

Apabila pada optical see-through pengguna melihat objek vir-
tual melalui optik yang diletakan di depan mata mereka, ma-
ka VRS akan menggambarkan objek-objek virtual tersebut lang-
sung ke retina mata.

3. Video See-Through

Perangkat Video See-Through merupakan perangkat yang di-
pasang dikepala yang memiliki kamera untuk mengambil gam-
bar dunia nyata yang ada di depan pengguna secara real-time.
Video yang diambil kemudian diproses untuk ditambahkan
objek-objek virtual dan ditampilkan pada pengguna melalui
monitor yang terdapat diperangkat tersebut.

4. Monitor Based AR

Monitor based AR juga menggabungkan video real-time de-
ngan objek virtual seperti halnya Video See-Through. Perbe-
daannya perangkat ini menggunakan monitor desktop atau
layar smartphone sehingga tidak harus dipasang di kepala.

5. Projector Based AR

Projector Based AR menggunakan sebuah objek sebagai alas
untuk menampilkan objek virtual. Perangkat ini banyak di-
gunakan untuk menampilkan contoh desain sebuah produk.
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1.5 Metode Marker

Metode yang dikembangkan pada Augmented Reality saat ini ter-
bagi menjadi dua metode, yaitu Marker Based Tracking dan Mar-
kless Augmented Reality.

1.5.1 Marker Based Tracking

Marker digunakan untuk sebagai penanda yang terekam dalam ka-
mera real time. Deteksi berbasis marker menggunakan pengolah-
an citra, yang akan menjadi peletakan objek (maya) dapat berupa
animasi 3D. Marker biasanya merupakan ilustrasi hitam dan putih
persegi dengan batas hitam tebal dan latar belakang putih.

1.5.2 Markerless Augmented Reality

Salah satu metode Augmented Reality yang saat ini sedang ber-
kembang adalah metode “Markerless Augmented Reality”, dengan
metode ini pengguna tidak perlu lagi menggunakan sebuah mar-
ker untuk menampilkan elemen-elemen digital.

Seperti yang saat ini dikembangkan oleh perusahaan Augmen-
ted Reality terbesar di dunia Total Immersion dan Qualcomm, me-
reka telah membuat berbagai macam teknik Markerless Tracking
sebagai teknologi andalan mereka, seperti Face Tracking, 3D Obje-
ct Tracking, dan Motion Tracking.

e Face Tracking

Algoritma pada computer terus dikembangkan, hal ini mem-
buat komputer dapat mengenali wajah manusia secara umum
dengan cara mengenali posisi mata, hidung, dan mulut ma-
nusia, kemudian akan mengabaikan objek-objek lain di seki-
tarnya seperti pohon, rumah, dan lain-lain.
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Gambar 1.2: Contoh Face Tracking

¢ 3D Object Tracking

Teknik 3D Object Tracking dapat mengenali semua bentuk
benda yang ada disekitar, seperti mobil, meja, televisi, dan
lain-lain.

Gambar 1.3: Contoh 3D Object Tracking

e Motion Tracking

Teknik Motion Tracking dapat menangkap gerakan, contoh-
nya seperti pada gambar 1.4 yang menampilkan informasi
dari sebuah kereta yang lewat dengan menangkap gerakkan-
nya.
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Gambar 1.4: Contoh Motion Tracking

e GPS Based Tracking

Teknik GPS Based Tracking saat ini mulai populer dan ba-
nyak dikembangkan pada aplikasi smartphone (iPhone dan
Android). Dengan memanfaatkan fitur GPS dan kompas yang
ada didalam smartphone, aplikasi akan mengambil data dari
GPS dan kompas kemudian menampilkannya dalam bentuk
arah yang kita inginkan secara realtime, bahkan ada bebera-
pa aplikasi menampikannya dalam bentuk 3D.

Gambar 1.5: Contoh GPS Based Tracking

1.6 Bidang Penerapan Augmented Reality

Bidang-bidang yang dapat menerapkan teknologi Augmented Re-
ality adalah:
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Kedokteran (Medical)

Teknologi pencitraan sangat dibutuhkan di dunia kedokter-
an, seperti misanya, untuk simulasi operasi, simulasi pem-
buatan vaksin virus, dll. Untuk itu, bidang kedokteran mene-
rapkan Augmented Reality pada visualisasi penelitian mere-
ka.

Hiburan (Entertainment)

Dunia hiburan membutuhkan Augmented Reality sebagai pe-
nunjang efek-efek yang akan dihasilkan oleh hiburan terse-
but.

Latihan Militer (Military Training)

Militer telah menerapkan Augmented Reality pada latihan tem-
pur mereka. Sebagai misalnya, militer menggunakan Augmen-
ted Reality untuk membuat sebuah permainan perang, dima-
na prajurit akan masuk kedalam dunia game tersebut, dan
seolah-olah seperti melakukan perang sesungguhnya.

Engineering Design

Seorang engineering design membutuhkan Augmented Rea-
lity untuk menampilkan hasil design mereka secara nyata ter-
hadap klien. Dengan Augmented Reality klien akan tahu, ten-
tang spesifikasi yang lebih detail tentang desain mereka.

Robotics dan Telerobotics

Dalam bidang robotika, seorang operator robot, mengunnak-
an pengendari pencitraan visual dalam mengendalikan ro-
bot.

Consumer Design

Augmented Reality telah digunakan dalam mempromosikan
produk. Seperti misalnya, seorang pengembang menggunk-
an brosur virtual untuk memberikan informasi yang lengkap
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secara 3D, sehingga pelanggan dapat mengetahui secara je-
las, produk yang ditawarkan.

1.7 SDK Augmented Reality

Beberapa penyedia SDK (Software Development Kit) terbaik untuk

pembuatan Augmneted Reality diantaranya adalah:

1. Vuforia

Vuforia adalah Augmented Reality Software Development Kit
(SDK) untuk perangkat mobile yang memungkinkan pembu-
atan aplikasi AR. SDK Vuforia juga tersedia untuk digabungk-
an dengan unity yaitu bernama Vuforia AR Extension for Uni-
ty. Perangkat lunak ini menerapkan fungsi pengenalan ber-
bagai jenis objek visual (box, cylinder, plane), text dan envi-
ronments recognition, VuMark (a combination of picture and
QR-code). Official website untuk developer dapat dikunjungi
dihttps://developer.vuforia.com

. Easy AR

Easy AR adalah alternatif yang mempunyai fungsi dan fitur

hampir sama dengan Vuforia. Fiturnya yaitu meliputi 3D Ob-

ject Recognition,Environment perception, Cloud Recognition.
Smart Glass Solution. App Cloud Packaging. Official website

dapat dikunjungi di https://www.easyar.com/

. Wikitude

Wikitude adalah penyedia teknologi berbasis ponsel Augme-
neted Reality dan didirikan pada tahun 2008, Wikitude awal-
nya difokuskan pada penyediaan berbasis lokasi augmented
reality pengalaman melalui Wikitude Dunia Browser App. Pa-
da 2012, perusahaan direstrukturisasi proposisi dengan me-
luncurkan Wikitude SDK, kerangka pembangunan memanfa-
atkan pengenalan gambar dan pelacakan, dan teknologi ge-
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olocation. Official website untuk developer dapat dikunjungi
dihttp://www.wikitude.com/

. KudanAR

KudanAR adalah salah satu penyedia SDK terbaik menggu-
nakan teknologi SLAM (Simultan Localization and Mapping),
sorotan teknologi Kudan, adalah teknologi Computer Vision
yang memecahkan masalah mencoba secara bersamaan: me-
lokalisasi (yaitu posisi / orientasi) sensor terhadap lingkungan-
nya, sementara di Pemetaan waktu yang sama dengan struk-
tur 3D lingkungan itu.

Sebagai pengakuan atas fleksibilitas dan kinerjanya yang cang-
gih, KudanSLAM telah mendapatkan lisensi dari sejumlah mi-
tra di berbagai industri, termasuk Self-Driving Cars, Drones,
Robotics and AR / VR. Official website untuk developer dapat
dikunjungi di https://www.kudan.eu/.
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i 2

Pengenalan Software Untuk
Membuat Aplikasi AR

2.1 Unity

Unity merupakan game engine sebuah perangkat lunak
yang digunakan untuk membuat games, simulasi, dan
bangunan arsitektur. Unity dapat diterapkan untuk ga-
me PC dan Game online memakai unity browser. Pem-
rograman yang digunakan bervariasi, antara lain Java-
Script, C#, dan Boo. Unity adalah sebuah game mul-
ti platform yang dapat digunakan pada PC, Mac, Wii,
iPhone, iPad, Android dan browser.

@unity

Gambar 2.1: Logo Unity

Tentunya tidak hanya multiplatform yang ditonjolkan di dalam

21



Pengenalan Software Untuk Membuat Aplikasi AR

Unity, ternyata game engine yang satu ini memiliki tingkat kemu-
dahan yang tidak jauh beda dengan game engine lain yang ada,
tentunya hanya dengan kemauan untuk belajar. Unity memiliki 2
versi yang berbeda tipis, yaitu versi gratis dan pro yang berbayar.

Perbedaan versi yang gratis dan berbayar terlihat di beberapa
fitur, antara lain AAA visual fidelity, special effects, dan ambience.
AAA visual fidelity merupakan fitur yang memberikan tampilan le-
bih menarik daripad versi gratis. Special effects adalah fitur yang
memberikan efek-efek menarik seperti ledakan, dan tabrakan. Se-
dangkan ambience adalah fitur yang berkaitan dengan shading ak-
sesbilitas, yang menentukan penampilan game. Unity juga memi-
liki sebuah Asset Store. Asset Store merupakan sebuah situs yang
memungkinkan kita untuk mendapatkan aset-aset yang dibutuhk-
an dalam membuat game sendiri.

Liaixi
Fle E6t_jusels Canedbiect Conponent. Tenan Toos Vindon_e

TR
c

Gambar 2.2: Unity

2.2 Vuforia

Vuforia merupakan library yang digunakan sebagai pen-
dukung adanya Augmented Reality pada Android. Vufo-
ria menganalisa gambar dengan menggunakan pende-
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Pengenalan Software Untuk Membuat Aplikasi AR

teksi marker dan menghasilkan informasi 3D dari mar-
ker yang sudah dideteksi via API.

. (@
vuforia &

by Qualcomm

Gambar 2.3: Logo Vuforia

2.2.1 Pengenalan Vuforia

Vuforia adalah Augmented Reality Software Development Kit (SDK)
untuk perangkat mobile yang memungkinkan pembuatan aplika-
si AR. SDK Vuforia juga tersedia untuk digabungkan dengan uni-
ty yaitu bernama Vuforia AR Extension for Unity. Perangkat lu-
nak ini menerapkan fungsi pengenalan berbagai jenis objek visual
(box, cylinder, plane), text dan environments recognition, VuMark
(a combination of picture and QR-code).

2.2.2 Fitur SDK Vuforia

e Image Targets

Dapat mengenali gambar dengan detail yang cukup terma-
suk majalah, iklan atau brosur serta kemasan yang tertera pa-
da produk.
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Gambar 2.4: Image Targets

e Multi Targets

Dapat mengenali lebih dari satu marker secara bersamaan.

Gambar 2.5: Multi Targets

e Cylinder Targets

Dapat mengenali benda seperti botol, cangkir, kaleng, dan
sebagainya.

24



Pengenalan Software Untuk Membuat Aplikasi AR

Gambar 2.6: Cylinder Targets

¢ Text Recognition

Mendukung pengenalan kata bahasa Inggris dari database stan-
dar 100.000 kata atau kosa kata kustom didefinisikan oleh pe-
ngembang.

Augmenpted:

o=

DETENER W&

kext Reco'ghition

Gambar 2.7: Text Recognition

o Frame Markers
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ID unik dari frame marker dikodekan ke dalam pola biner se-
panjang perbatasan gambar marker. Sebuah frame marker
memungkinkan gambar apapun untuk ditempatkan dalam
batas-batas marker.

Gambar 2.8: Frame Markers

26



w3

Instalasi Software

3.1 Instalasi Software Unity

Untuk membuat sebuah aplikasi Augmented Reality, terlebih da-
hulu Anda harus mengunduh software Unity versi terbaru karena
plugin vuforia hanya dapat digunakan pada Unity versi 5 ke atas.
Anda dapat mengunduh Unity lewat website resminya di https:
//store.unity.com/ Unity versi terahir saat ini dibuat adalah Uni-
ty 2017.2.013. Klik Get Unity.

2 Unity - Store X G fungsiandroid sdk - Penelu. X | B Google Terjemahan X | @ Bela A X | 5 Mengenl x|+

€0

a x instal > A wBe 9

store.unity.com

Unity 2017 introduces new features that help teams of
artists and developers build experiences together. Powerful
new tools, such as Timeline and Cinemachine, empower
artists to create cinematic content and gameplay
sequences without the need of an engineer. Creators can
now spend more time doing, less time queueing.

Personal Plus Pro

Free $35/month $125/month Get Unity
For beginners, students, and For serious creators For professionals and studios
hobbyists

We use cookies to ensure that we give you the best experience on our website. Click for more information.

Gambar 3.1: Get Unity

Unity dapat digunakan secara gratis dengan memilih Try Per-
sonal, tetapi apabila ingin membeli versi Pro dapat dibeli dengan
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harga 125 USD perbulan. Perbedaan versi gratis dan versi pro da-
pat dilihat pada gambar 3.2. Silahkan Anda pilih Try Personal jika
ingin menggunakan versi gratis.

& 5 O H soeuiyon 2 1%

0 see favorites here, select 3= then +, and drag to the Favorites Bar folder. Or import from another browser. Import favorites

Ready to start creating?
Choose a plan that's right for you.

Ryan

Hithere

Pro oitarg

Personal Plus ===

Free S3 5 permonth S‘] 25 permonth

For beginners, students and For creators who are serious For professionals ’5’1:0“Of
hobbyists who want to explore about bringing their vision to life complete flexibilit,  peeqs
and get started with Unity. and plan to publish. advanced cul

Gambar 3.2: Perbedaan Unity Gratis dan Berbayar

Setelah berhasil mengundubh file installer, jalankan installer yang

telah Anda unduh. Kemudian ikuti langkah di bawah ini.

< Unity 2017.2.0f3 Download Assistant == b4

Unity 2017.2.0f3 Download
Assistant

This assistant will quide you through downloading and
installing Unity.

Please make sure you stay connected to the Internet during
the installation process, as Unity components will need to be
downloaded.

Click Mext to continue,

Gambar 3.3: Langkah pertama Instalasi Unity

Beri tanda cek pada “accept the terms of License Agrement”, la-
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lu tekan Next.

=+ Unity 2017.2.0f3 Download Assistant

License Agreement @

Please review and accept the license terms before downloading and installing Unity.

Unity Terms of Service

Last updated: August 30, 2017

Unity Technologies ApS (“Unity”, “our” or “we’} provides game-

development and related software (the “Software”), development-related

[A11 accept the terms of the License Agreement 3 Prlnt

Unity 2017.2.0F3 Download Assistant

T e R

Gambar 3.4: Langkah kedua Instalasi Unity

Beri ceklis seperti pada gambar di bawah ini. Anda harus me-
nyiapkan space hardisk sebesar minimal 3.9 Gb untuk menginstal
Unity.

<4 Unity 2017.2.0f3 Download Assistant

Choose Components
Choose which Unity components you want to download and install, @
Description
Unity 2017.2.0F3 A )
MonoDevelop / Unity Debugger Fozition your mouse over &

component to see itz description.
Documentation

Standard Assets

[] Example Project

Microsoft Visual Studio Community 2017
Android Build Support

1105 Build Support

[1tws Build Support

[ Linux Build Support

[ Mac Build Support

[] Windows Store .NET Scripting Backend

..... a7 Install space required: 3.9GE
Uniky 2017.2.0F3 Download Assiskant

T e

Gambar 3.5: Langkah ketiga Instalasi Unity
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Pilihlah “Download To” apabila Anda ingin menyimpan Insta-
ller dari Unity. Kemudian tekan Next.

< Unity 2017.2.0f3 Download Assistant

Choose Download and Install locations
Spedfy where to download and install files. @

Spedify location of files downloaded during installation
(O) Download files to temporary location (will automatically be removed when done)

(®) Dowrload to: | C:\Users\Comet\Downloads |

Browse...

Unity install folder

| C:\Program FilesUnity| Browse. ..

Total space required: 6.0 GB
Space available: 32.7 GB

Unity 2017, 2.0F3 Download Assiskank

Gambar 3.6: Langkah keempat Instalasi Unity

Beri tanda ceklis pada “accept the terms of License Agrement”,
lalu tekan Next.

30



Instalasi Software

2 Unity 2017.2.0f3 Download Assistant

License Agreement
Please review and accept the license terms before downloading and installing @
Microsoft Visual Studio.

Visual Studio 2017 Community License Terms

11 accept the terms of the License Agreement

Unity 2017.2.0F3 Download Assistant

Gambar 3.7: Langkah kelima Instalasi Unity

Setelah itu tunggulah sampai proses unduh dan proses instalasi
selesai.

= Unity 2017.2.0f3 Download Assistant

Downloading and Installing
Please wait while Unity is being downloaded and installed. @

Dewnloading Unity 2017, 2.0f3

Show details

416kE (0%%) of 502242kB @ 104.0kB/s (1 hour remaining)

Cancel

Unity 2017 ,2.0F3 Download Assistant

< Back Next > Cancel

Gambar 3.8: Langkah keenam Instalasi Unity

Selanjutnya reboot(restart) PC/Laptop agar menyelesaikan in-
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stalasi.

< Unity 2017.2.0f3 Download Assistant —

Completing the Unity Setup

Your computer must be restarted in order to complete the
installation of Unity. Do you want to reboot now?

()1 want to manually reboot later

< Back Cancel

Gambar 3.9: Langkah ketujuh Instalasi Unity

Setelah reboot, langkah selanjutnya yaitu mendaftar akun pilih

“create one”, tetapi apabila sudah memiliki akun tinggal ke selan-

jutnya yaitu login akun.
& unity

Sign into yoj

If you don't have a Unity ID, pidase create an

Email

] sign in with facebook

Sign in with google
r

Gambar 3.10: Langkah kedelapan Instalasi Unity

Kemudian isilah form pendaftaran tersebut. Kata sandi harus
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memiliki unsur huruf besar, angka, dan terdiri dari minimal 8 ka-
rakter. Jangan lupa ceklis kolom “I agree”. Lalu klik “Create a Unity
ID”.

&) unity

Create a Unity ID

If you already have a Unity ID, please sign in here.
Email Password

o R N

Username Full Name
[ hadi rahmadi
1 agree to the Unity Terms of Use and Privacy Pchc ‘ A ‘ Create a Unity ID

Get Unity news, discounts and more!

Or

Gambar 3.11: Langkah kesembilan Instalasi Unity

Setelah berhasil membuat akun Unity, selanjutnya bukalah e-
mail yang telah didaftarkan sebelumnya. Klik “Link to confirm ema-

il”.

Dear hadi rahmadi,

Thank you for creating a Unity ID

Click the below link to confirm your email. The link will expire in 15 days.

Link to confirm email

Please go to support.unity3d.com to get help with any questions about your Unity 1D,
account, organization(s) and subscription(s).

Sincerely,
The Unity Team

Gambar 3.12: Langkah kesepuluh Instalasi Unity

Anda akan mendapatkan sebuah e-mail dari Unity Technologi-

33



Instalasi Software

es. Kemudian kembali ke Unity, klik Continue.

< Unity 2017.2.0F3

&} unity

Confirm your Email

Please check your inbox for a confirmation email. Click the link in the email to confirm your email address.
After you confirm click Continue.

Gambar 3.13: Langkah kesebelas Instalasi Unity

Unity telah selesai terinstal, selanjutnya tutup/Close Unity de-
ngan klik tanda silang.

< Unity 2017.2.03 X

Projects  Learn Bnew  [Hopen (@) wyAccount

=
= ‘
=

Pl 01:Play & Edit Mode

Bl Take your first steps inside the Unity editor, as you learn the difference between the 2 main
Sl modes in Unity - Edit mode for working on your projeet, and Play mode for testing

Basic Tutorials

Tutorial Projects

Resources 02 : Game Objects & Components - Rigidbodies to the rescue
We build games in Unity using Game Objects and components. Lear about how adding a
Links Rigidbody component to your game objects adds Physics behaviour

03 : Tweaking Components - Values vs Zombies
Develop your compenent knowledge further as you leamn about values and how they affect
gameplay. Can you slew down the polygon-eating zombie in time o escape?

04 : Prefab power -

% I

Gambar 3.14: Langkah keduabelas Instalasi Unity

3.2 Instalasi JDK (Java Development Kit)

JDK(Java Development Kit)adalah Perangkat lunak yang digunak-
an untuk melakukan proses kompilasi dari kode java ke bytecode
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yang dapat dimengerti dan dapat dijalankan oleh JRE (Java Runti-
me Envirotment). JDK(Java Development Kit) wajib terinstall pada
komputer yang akan melakukan proses pembuatan aplikasi ber-
basis java. JDK(Java Development Kit) versi terakhir yang saat ini
dibuat adalah JDK 9.

Anda dapat mengunduhnya dihttp://www.oracle.com/technetwork/
pt/java/javase/downloads/jdk8-downloads-2133151 . html

Unduh versi Windows, seperti pada gambar dibawah ini. Ceklis
pada “Accept License Agreement”, dan pilih salah satu sesuai versi
Windows yang Anda gunakan.

Java SE Development Kit 8u144

You must accept the Oracle Binary Code License Agreement for Java SE to download this
software.
Thank you for accepting the Oracle Binary Code License Agreement for Java SE; you may
now download this software,

Preduct / File Description File Size Download
Linux ARM 32 Hard Float ABI 77.89 MB  #jdk-Su144-linux-arm32-vfp-hfit tar.gz
Linux ARM 64 Hard Float ABI 74.83 MB  #®jdk-5u144-linux-arm&4-vip-hitt tar.gz
Linux x&6 164.65 MB  #jdk-8u144-linux-i536.rpm
Linux x58 179.44 ME  #jdk-5u144-linux-i536.tar.gz
Linux x64 162.1 ME  #®jdk-5u144-linux-x64.rpm
Linux x64 176.92 ME  #jdk-Su144-linux-x64 tar.gz
Mac O3 X 2266 MB #jdk-5ul44-macosx-x64.dmg
Solaris SPARC 64-bit 138.87 MB  #jdk-Bu144-solaris-sparcvd tar.Z
Solaris SPARC 64-bit 99.18 MB  #jdk-5u144-solaris-sparcvi tar.gz
Solaris x64 140.51 ME  ®jdk-Su144-solaris-x64.tar.2
Eﬂ ii'i‘ 24 oo o0 BB _Bidl Sy A4 ool B for oo
Windows x86 190.94 MB  #jdk-8u144-windows-i586. exe
Windows x64 197.75 MB  #jdk-Su144-windows-x64.exe

Gambar 3.15: Langkah pertama Instalasi JDK

Setelah selesai mengunduh, selanjutnya menginstal JDK. Jalank-
an file setup “jdk-9_windows-x64_bin.exe” yang telah di download
seperti gambar dibawah ini. Double klik pada setup tersebut.
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§

jdk-Buldd-window
s-x6d. exe

Gambar 3.16: Langkah kedua Instalasi JDK

Kemudian akan tampil setup JDK, lalu klik Next

ji& Java(TM) SE Development Kit 9 (64-hit) - Setup

K

—
—
e

> Java

CRACLE

Welcome to the Installation Wizard for Java SE Development Kit 9

This wizard will guide you through the installation process for the Java SE Development
Kit 9.

The Java Mission Control profiling and diagnostics tools suite is now available as part of
the JDK.

I Next = I Cancel :

Gambar 3.17: Langkah ketiga Instalasi JDK

Dan selanjutnya akan tampil jendela Custom Setup klik Next
dan biarkan Default.
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iiF Java(TM) SE Development Kit 9 (64-bit) - Custom Setup

Select optional features to install from the list below. You can change your choice of features after
installation by using the Add/Remove Programs utility in the Control Panel
Feature Description
Development Tools Java(TM) SE Development Kit 9
‘=~ Source Code (&4+bit), induding the JavaFX
3 SDK, a private JRE, and the Java
=)~ | Public JRE Mission Control toals suite. This
will require 180MB on your hard
drive.
Install to:
C:Program Files\Javaljdk-9} iw
|  <Back || mNext> ||  Cancel '

Gambar 3.18: Langkah keempat Instalasi JDK

Selanjutnya muncul jendela Destination Folder dimana pemi-
lihan instalasi JRE defaultnya jika ingin memilih lokasi lain, Anda
dapat mengklik change untuk menentukan pemilihan lokasi yang
lainnya, setelah itu klik Next.

Java Setup - Custom Setup

Custom Setup

Click "Change" to install Java to a different folder.

C:\Pregram Files\Java\jre-9

Enable Java Content in the Browser

Gambar 3.19: Langkah kelima Instalasi JDK
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Setelah itu tunggu hingga proses instal selesai

Java Setup - Progress

Status: Installing Java

I

3 B I I I I
Devices Run Java

";’ Java #1 Development Platform m

Gambar 3.20: Langkah keenam Instalasi JDK

Selanjutnya muncul jendela Complete yang artinya proses In-
stalasi Java Development Kit (JDK) selesai. Klik Close untuk meng-

akhiri.
ii& Java(TM) SE Development Kit 9 (64-bit) - Complete

-'._'.{ ;] -

= Java
CERACLE

Java(TM) SE Development Kit 9 (64-bit) Successfully Installed

Click Mext Steps to access tutorials, API documentation, developer guides, release notes

and more to help you get started with the JDK.

Mext Steps

Close

Gambar 3.21: Langkah ketujuh Instalasi JDK

38



Instalasi Software

3.3 Instalasi Android SDK

Android Studio adalah sebuah IDE yang bisa digunakan untuk pe-
ngembangan aplikasi Android, dan dikembangkan oleh Google. An-
droid Studio merupakan pengembangkan dari Eclipse IDE, dan di-
buat berdasarkan IDE Java populer, yaitu Intelli] IDEA. Android
Studio direncanakan untuk menggantikan Eclipse ke depannya se-
bagai IDE resmi untuk pengembangan aplikasi Android.

Android SDK adalah tools API (Application Programming In-
terface) satu set alat pengembangan yang diperlukan untuk mu-
lai mengembangkan aplikasi pada Android menggunakan bahasa
pemrograman Java. Anda dapat mengunduh Unity lewat website
resminya di:

https://developer.android.com/studio/index.html.

& Android Studio

< Back to Developers

DDDDDDDD Android Studio

nnnnnnnn

The Official IDE for Android

sssssssss

Gambar 3.22: Langkah pertama Instalasi Android Studio

Ceklis pada “I have read and agree with the above terms and
conditions”.
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Before downloading, you must agree to the following terms and conditions.

Terms and Conditions

This is the Android Software Development Kit License Agreement

1. Introduction

1.1 The Android Software Development Kit (referred to in the License Agreement as the "SDK" and specifically including the Android system
files, packaged APIs, and Google APIs add-ons) is licensed to you subject to the terms of the License Agreement. The License Agreement
forms a legally binding contract between you and Google in relation to your use of the SDK.

1.2 "Android" means the Android software stack for devices, as made available under the Android Open Source Project, which is located at
the following URL: http://source.android.com/, as updated from time to time

1.3 A "compatible implementation” means any Android device that (i) complies with the Android Compatibility Definition document, which 5

I have read and agree with the above terms and conditions

DOWNLOAD ANDROID STUDIO FOR WINDOWS

Gambar 3.23: Langkah kedua Instalasi Android Studio

Lalu “Save File” untuk mengunduh, dan tunggu hingga proses
download selesai.

Opening android-studic-bundle-162.4069337-windows.exe

You have chosen to open:
[#=] android-studio-bundle-162.4069837-windows.exe

which is: Binary File (1.9 GB)
from: https://dl.google.com

Would you like to save this file?

| Sawve File | | Cancel |

Gambar 3.24: Langkah ketiga Instalasi Android Studio

Setelah proses download selesai, selanjutnya instal Android Stu-
dio.
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s

Manage

Home Share View

5 1 4 cut E G o
EE ] LE x -l =
E| L
J —-J W Copy path * 1
P Copy Paste 58 Move Copy Delete Rename Mew
P] Paste sho tout to~ to - - folder
Clipboard Organize ]
&« v » ThisPC » Downloads * Programs
~

s Quick access
[ Desktop
-‘ Downloads

|| Documents . i
: android-studio-b
| Pictures undle-145.336026

Gambar 4-windows.exe

Lagu Lama

Model 3D jadi

Gambar 3.25: Langkah keempat Instalasi Android Studio

Berikut ini adalah langkah untuk menginstal Android Studio.
Jalankan installer yang telah Anda unduh sebelumnya, klik tombol
Next.

@ Android Studio Setup — X

Welcome to Android Studio Setup

Setup will guide you through the installation of Android
Studio.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

Gambar 3.26: Langkah kelima Instalasi Android Studio
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% Android Studio Setup

Choose Components
Choose which features of Android Studio you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install: Android Studio De;alphon
. Position your mouse
Android SDK over a component Eo
Android Virtual Device see its descripion,

Space required: 4.8GB

Gambar 3.27: Langkah keenam Instalasi Android Studio

Setelah itu akan muncul lokasi penyimpanan instalasi Android
Studio. Perlu dicatat untuk lokasi Android SDK karena lokasi pe-
nyimpanan tersebut yang nantinya akan digunakan untuk Unity.
Kemudian klik Next.

&% Android Studio Setup

Configuration Settings
Install Locations

android Studio Installation Location

The location spedfied must have at least 500MB of free space.
Click Browse to customize:

| C:\Program Files\Android\Android Studia| * Browse.. |

Android DK Installation Location

The location spedified must have at least 3.2GE of free space.
Click Browse to customize:

| C:\Wsers\Comet\AppData'Local \Androidisdk Browse...

< Back _ Cancel

Gambar 3.28: Langkah ketujuh Instalasi Android Studio
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Kemudian tekan Install, dan tunggu hingga proses instalasi An-
droid Studio selesai.

&% Android Studio Setup

Choose Start Menu Folder
Choose & Start Menu folder for the Android Studio shortcuts.

Select the Start Menu folder in which you would like to create the program's shortouts, You
can also enter a name to create a new folder.

|

Accessibility A
Accessories

Administrative Tools

Adobe Master Collection CS6
Android Studio

Autodesk

Autodesk 3ds Max 2014

Autodesk Backburner 2014
Autodesk Composite 2014
Bandicam

Blender

[] Do not create shortcuts

<Back | Install Cancel

Gambar 3.29: Langkah kedelapan Instalasi Android Studio

& Android Studico Setup

Installing
Please wait while Android Studio is being installed.

Extract: rt.jar... 79%

Show details

< Back Next = Cancel

Gambar 3.30: Langkah kesembilan Instalasi Android Studio

Setelah selesai, tekanlah tombol Finish.
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s Android Studio Setup 1=

Completing Android Studio Setup

Android Studio has been installed on your computer.

Click Finish to dose Setup.

[ start android Studio

Android
Studio

Gambar 3.31: Langkah kesepuluh Instalasi Android Studio
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Membuat Aplikasi Augmented
Reality Sederhana

Pertama-tama jalankan terlebih dahulu software Unity yang telah
Anda instal. Buatlah sebuah projek baru dengan memilih New Pro-

ject.

£ Unity 2017.2.013 X

o s -
) New +] Open (@) My Account

Projects  Learn

101

01 : Play & Edit Mode
Take your first steps inside the Unity editor, as you learn the difference between the 2 main u
modes in Unity - Edit mode for working on your project, and Play mode for testing.

Basic Tutorials £
" =
Tutorial Projects

02 : Game Objects & Components - Rigidbodies to the rescue

(s We build games in Unity using Game Objects and components. Learn about how adding a &=
Links = Rigidbody component to your game objects adds Physics behaviour

Resources

03 : Tweaking Components - Values vs Zombies

Develop your component knowledge further as you leam about values and how they affect -
gameplay. Can you slow down the polygan-eating zombie in time to escape?

] 4

04 : Prefab power - Ramping up
Prefabs are the secret sauce behind all Unity games, in this lesson you'll learn about building -
them as you ramp up your knowledge and escape another laser death trap!

Gambar 4.1: New Projects

Selanjutnya beri nama projek Anda sesuai keinginan, atur lo-
kasi penyimpanan projek dan pilih 3D karena projek akan ditam-
bahkan objek 3 Dimensi, lalu klik Create project.
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< Unity 20172003
Projects  Learn [Bner  [Popen @ Myaccount
| #3002 (]
C:\Users\Comet\Documents e (@ oFF ) Enable Unity Analytics ()

Gambar 4.2: Project name

Tunggu beberapa saat maka akan terbuka tampilan jendela Uni-

Gambar 4.3: Jendela Unity

Masuklah ke menu Edit, lalu pilih Preferences, maka akan tam-
pil jendela Preferences.
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Ctri+Z

Redo Ctrl+Y ey
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Duplicate Ctrl+D
Delete Shift+Del
Frame Selected F
Lock View to Selected Shift+F
Find Ctrl+F
Select All Ctrl+&
Modules...

Play Ctrl+P
Pause Ctrl+5hift+P
Step Crl+Alt+P
Sign in...

Sign out

Selection »

Gambar 4.4: Menu Preferences

Unity Preferences

General

External Tools

Colors

Keys

GI Cache

2D

Cache Server

Diagnostics

Gambar 4.5: Unity Preferences

Pilihlah menu External Tools, kemudian isilah lokasi Android
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SDK dari Android Studio dan lokasi JDK yang telah Anda instal. Lo-
kasi default dari Android SDK biasanya terdapat pada “C:\Users\”Nama
Komputer”\AppData\Local\Android\sdk”

dan Lokasi default dari JDK biasanya terdapat pada “C:\Program
Files\Java\jdk1.8.0_144"

Apabila folder AppData tidak ditemukan, biasanya bersifat Hi-
dden File, maka Anda harus menampilkan Hidden File Anda terle-
bih dahulu.

Unity Preferences x

External Tools

General | External Script Editor [ MoneDevelop (built-in) ¢ | &
Add .unityproj's to .sln [
External Tools Editor Attaching ¥4
Colors Image application | Open by file extension 3|
Kays Revision Contral DifffMerge [ :]
No supported WCS diff tools were found. Please
GI Cache & install one of the following tools:
- SourceGear DiffMerge
oD - TkDiff
- P4Merge
- TortoiseMerge
Cache Server - WinMerge
- PlasticSCM Merge
Diagnostics - Beyond Compare 4
A ™ |
SDK |C:/Users/Comet/AppData/Local/t | Brawse || Dawnload

JDK [C:/Program Files/ava/idk1.8.0_1 | Brawse || Dawnload |

NDK Browse || Download

s 2 i ' e S T

Gambar 4.6: Mengatur Lokasi Android SDK dan JDK

Setelah selesai, maka anda dapat menutup jendela Preferences.
Kemudian dari menu File pilihlah Build Setting.
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File Edit Assets GameObject Compt

Mew Scene Ctri+M
Open Scene Ctrl+0
Save Scenes Ctrl+5
Save Scene as... Ctrl+5hift+5
Mew Project...

Open Project...

Save Project

Build Settings... Ctrl+5hift+B
Build & Run Ctrl+B
Exit

Gambar 4.7: Build Setting

Setelah itu akan muncul jendela Build Setting, klik Android >
Switch Platform, selanjutnya klik Add Open Scenes lalu save. Ke-
mudian klik Player Setting yang terdapat pada bagian bawah menu
Build Setting.
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i Build Settings

;_ PC, Mac & Linux §tandalone =
>

PS Vita -
ml Hiaomi Mi Game Center

=.ra Ps4
=

Gambar 4.8: Menu Build Setting

4.1 Membuat Uang 3D Augmented Reality

Setelah Anda mengklik Player Setting, silahkan Company Name dan
nama aplikasi pada Product Name sesuai keinginan Anda.

@ Inspcctor

@ . PlayerSettings

Gambar 4.9: Memberi Nama Company dan Nama Aplikasi
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Pada Tab Inspector, pilih Other Setting lalu sesuaikan dengan
pengaturan tadi yang telah anda buat, tetapi tanpa spasi.

Splash Image -

Other Settings

Rendering

Color Space* | Gamma el
Auto Graphics API [

Multithreaded Rendering® [«

Static Batching
Dynamic Batching o
GPU Skinning* ]
Graphics Jobs (Experimer| |

<

Virtual Reality moved to ¥R Settings

Protect Graphics Memory ||

Identification

Package Mame com.hadi.uang3d

Version® 0

Bundle Version Code [1] [
Minimum API Level | Android 4.1 'Jelly Bean' (API lev |
Target API Level | Autornatic (highest installed) 4|

Gambar 4.10: Package Name

Sebelum melanjutkan membuat aplikasi, langkah selanjutnya
yaitu mendaftar akun Vuforia terlebih dahulu, dan mengimport
package.

4.1.1 Pendaftaran Akun Vuforia

Vuforia merupakan library yang digunakan sebagai pendukung ada-
nya Augmented Reality pada Android. Vuforia menganalisa gam-
bar dengan menggunakan pendeteksi marker dan menghasilkan
informasi 3D dari marker yang sudah dideteksi via API.

Langkah pertama yang perlu dilakukan adalah mendaftar akun
pada website resmi Vuforia. Silahkan Anda buka website Vuforia
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https://developer.vuforia.com/ padaweb browser Anda. Kemu-
dian klik tombol Register seperti pada gambar dibawah ini.
Vuforia Developar Port: X —

> U A decopeboracon el

Yorites here, select # then +, and drag to the Favorites Bar folder. Crimport from anozher browser. Import favorites

s vuforia- peveloper Fertal Login | Register

Home Pricing Downloads Library Develop Support

October 02,2017

Vuforia Platform Update

Gambar 4.11: Website Vuforia

Setelah itu, isilah semua form pada halaman website Vuforia.
Password dan kata sandi harus mengandung huruf kapital, huruf
kecil, angka, dan terdiri minimal 8 karakter.

Register for a Vuforia Developer Account

First Name Last Name

Hadi Rahmat

Company Country

TNG Indonesia

Email Address Username

comet mca@gmail.com Hadi&3

Password Canfirm Password
*00000OS o000000O

Fiy crc.:atirg an account you agree to the
Vuforia Developer Agreement.
Gambar 4.12: Daftar Akun Vufora

Apabila pendaftaran telah berhasil, maka akan muncul notifi-
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kasi email yang Anda daftarkan tadi perlu dikonfirmasi terlebih da-
hulu.

Thank You

An email will be sent to comet.mca@gmail.com with instructions to

Gambar 4.13: Notifikasi Setelah Berhasil Mendaftar

complete registration.

Lalu bukalah email yang telah Anda daftarkan tadi. Anda akan
menerima email dari Vuforia, kemudian klik link konfirmasi terse-
but.

)

@, vuforig-

«

Dear Hadi,
Thank you for registering at Wuforia's Developer Portal.

Your account has been created with the email address
comet.mca@amail.com.

Click the following link to complete your registration
https:ifdeveloper. vuforia.com/user/confirm?e=comet. mca@gmail. comé&t=
awXTkGekOHYcVAKIKYLFRhgLhybcLkjlpzPiBPETEIVWuUbSGdslyColWnhmL

QfaD

IT you have any issues accessing the link above please copy and paste it directly
in your browser.

Thank you,

The Vuforia Team

Gambar 4.14: Link untuk Konfirmasi Registrasi

Setelah konfirmasi, maka akan muncul form login, silahkan An-
da login dengan akun Vuforia yang telah Anda buat.

53



Membuat Aplikasi Augmented Reality Sederhana

@ vuforia~ Developer Portal

Home Pricing Downloads Library Develop Support

Login

Email Address
comet.mca@gmail.com

Not Registered? Create account now

Password

Forgot password?

Gambar 4.15: Login Akun Vuforia

Setelah itu klik tombol “Get Development Key” untuk membuat
License baru.

s vuforia~ Developer Portal

Home Pricing Downloads Library Develop

License Manager Target Manager

License Manager

Create a license key for your application.

Get Development Key Buy Deployment Key

Name Type Status v

Create your first license key

Gambar 4.16: Mendapatkan Kode Lisensi Baru

54



Membuat Aplikasi Augmented Reality Sederhana

Kemudian akan muncul form, isilah form tersebut dengan na-

ma sesuai keinginan Anda, sebagai contoh akan diberi nama “Au-

gmented Reality”. Kemudian ceklis box “Bye checking this box”, ke-

mudian pilih Confirm.

Home Pricing Downloads Library Develop Support

License Manager Target Manager

Back To License Manager

Add a free Development License Key

App Name

Augmented Reality You can change this later

License Key

Develop

Price: No Charge

Reco Usage: 1,000 per month
Cloud Targets: 1,000
VuMark Templates: 1 active
VuMarks: 100

El checking this box, | acknowledge that this license key is subject to the terms
ad conditions of the Vuforia Developer Agreement.

Cancel Confirm

Gambar 4.17: Memberi Nama Kode Lisensi

Setelah berhasil, maka akan muncul nama License Manager,
kemudian klik “Augmented Reality”.
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$ vuforia~ Developer Portal

Home Pricing Downloads Library Develop Support

License Manager Target Manager

License Manager

Create a license key for your application.

Get Development Key Buy Deployment Key
Name Type
Augmented Reality Develop

Gambar 4.18: Lisensi Manajer

Maka akan muncul kode lisensi, yang akan digunakan untuk li-
sensi pada ARCamera nanti, silahkan Anda salin dan simpan terle-
bih dahulu kode lisensi tersebut.

License Manager » Augmented Reality

Aug me’nted Reality Edit Name Delete License Key

License Key Usage

Please copy the license key below into your app

Ebsjbvn/////ARBAGYMZNCIzikE3mPOSChGMSPReZCLREVS3NWTg
T4d0bnWEEOT 1 hEmQGt smiVZ1vlibXCykZNPfPgOfuj tuwEfz+t 20
rLicd4N0aaB0fN3ibskz3Z50pIndI2a¥uV1LOWei0SGEMICAOMSk]
rlUFltFMkx704JqILryFlgTe fLvdvOogghUgqwmrRs4mTS58ZjqyiEH
yE+iHiarNBGWVpotm+vYyJIlGayVgBr/ PYwngrpyfl4gCmdy8 PCcW
v749bEWpcgEQCTUCiwLr ICpBVSVXERP3£3yalqCag+WhVGFHTE/NQ
BemOMfxZDI7Golly ] PCHi3jXvETj1d3iNhe2iqaViUFo+EDvsHVE
BO98c58YRnFulThir

Gambar 4.19: Kode Lisensi

Tahap selanjutnya membuat marker dari sebuah gambar 2D, si-

56



Membuat Aplikasi Augmented Reality Sederhana

lahkan klik Target Manager dan tambahkan database marker, klik
Add Database.

Home Pricing Downloads Library Develop Support

License Manager Target Manager

Target Manager

Use the Target Manager to create and manage databases and targets.

Add Database

Gambar 4.20: Tambah Database Target Manajer

Kemudian beri nama sesuai keinginan Anda, lalu klik Create.

Create Database

Name:

ARmarker|

Type:

@ Device
O) Cloud
O VuMark

Cancel Create

Gambar 4.21: Membuat Database Marker

Maka akan muncul database Target Manager, kemudian klik da-
tabase tersebut.
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License Manager Target Manager

Target Manager

Use the Target Manager to create and manage databases and targets.

Add Database

Database Type

ARmarker Device

Gambar 4.22: Berhasil Membuat Database Marker

Kemudian pilih marker yang Anda inginkan, karena akan mem-
buat Uang 3D jadi marker yang digunakan yaitu marker gambar
uang. Setelah semua form terisi, selanjutnya klik Add.

A |« MO.. > Materi WORKSHO... ~ | ®| | Search Materi WORKSHOP AR... @
Organize > New folder =- @ @ 3
another browser. Import favorites
A ~
[ This PC
[ Desktop

% Documents

$ Downloads 1000 . ‘ 008 v
b Music : ] - |J (= .E

&1 Pictures
1807_87922304¢3eed 30L.j 20000,jpg

TT

T

g id dind 3D Object
B Videos ke 4
P9
i Local Disk (<) w 1
— Data (D) v B !e] H v
Browse_
File name: | 20000.,jpg | | Allfiles %) Y
Enter the width of your target in scene units. The size of the target should be on the
sar le a5 your sugmented virtual content Vuforia uses meters as the default unit

target's height will be calculated when you upload your image.
Name:
marker20000

Name must be unique to a database. When a target is detected in your application, this
will be reported in the APL

Gambar 4.23: Menambahkan Marker

Perhatikan juga Rating dari marker yang Anda buat, semakin
banyak bintang tersebut, maka target akan semakin mudah terde-
teksi saat di-scan. Kemudian klik Download Database.
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ARmarker =zstname
Type: Device

Targets (2)

Add Target Download Database (1)

O Target Name Type Rating Status v Date Modified

1selected Delete

] 3‘ marker20000 Single Image : Active Oct 19, 2017 12:06

Gambar 4.24: Berhasil Membuat Marker

Lalu akan muncul pop-up, pilihlah Unity Editor, kemudian klik
Download.

Download Database

1 of 2 active targets will be downloaded

Name:
ARmarkesr
Select a development platform:

(Android Studio, Xcode or Visual Studio
{@) Unity Editor

Cancel Download

Gambar 4.25: Unduh Database

Setelah klik download tadi, maka Anda akan mendapatkan file
dengan format .unitypackage.

Gambar 4.26: Hasil Unduh Package Marker
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4.1.2 Vuforia SDK

Selanjutnya buka tab Downloads, kemudian Download “Unity Exten-
sion (legacy)”.

Home Pricing Downloads Library Develop Support

SDK Samples Tools Early Access

Vuforia 6.5

Use the Vuforia SDK to build Androeid, iOS, and UWP applications for mobile
devices and digital eyewear. Apps can be built with Android Studio, Xcode, Visual
Studio, and Unity.

As of Unity 2017.2, Vuforia is delivered with the Unity Editor. A legacy version of

the Vuforia Unity Extension is provided to assist with project migrations.

* Download for Android
vuforia-sdk-andreid-6-5-23.zip (1229 ME)

IOS Download for i0S
vuforia-sdk-ios-6-5-23.zip (16.11 MEB)

mml PDownload for UWP
vuforia-sdk-uwp-6-5-23.zip (7.42 MB)

Quri Download Unity Extension (legacy)
vuforia-unity-6-2-10.unitypackage (46.20 MB)

Download Unity
Vuforia is integrated with the Unity Editor

Qunity

Gambar 4.27: Unduh Package Vuforia

Setelah berhasil mengunduh, maka Anda akan mendapatkan
file package Vuforia, dengan format .unitypackage.

Gambar 4.28: Hasil Unduh Package Vuforia
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4.1.3 Tahap pembuatan Aplikasi

Selanjutnya buka kembali projek Unity, lalu Import package Vufo-
ria. Klik Assets > Import Package > Custom Package.

<4 Unity 2017.2.0f3 Personal {64bit) - Augmented Reality.unity - AR 1 - Andreid <DX11 on DX9 {
File Edit Assets GameObject Component Window Help

Create >

“= Hierarel Show in Explorer

Create * | | Open

¥ € Augn Delete
Main C
Directi Open Scene Additive
Import New Asset...
Import Package Custom Package...
Export Package... o
Find References In Scene
Cameras
Select Dependencies Characters
Refresh Ctrl+R CrossPlatforminput
Reimport Effects
Reimport All Environment
ParticleSystems
Extract From Prefab Prototyping
Run APl Updater... Utility
— Open C# Project pebickes
1 Proiect —

Gambar 4.29: Import Package

Kemudian Import kedua package yang telah Anda unduh tadi.
Import Vuforia Terlebih dahulu kemudian Import ARmarker.

< un

File Edit Assets GameObject Component Window Help

f3 Personal (64bit) - Augmented Reality.unity -

€ Import package ...

J 4 Bl > ThisPC » Desktop v @ | SearchDesktop »p
Organize v New folder Bz~ T @
Video A Mame Date modified Type
OneDrive € vuforia-unity-6-2-10.unitypackage Unity package file
€0 ARmarker.unitypackage Unity package file
O This PC
= kU AR File folder
[ Deskiop Model 3D jadi File folder
Documents 3dsmax File folder
4 Downloads Hadi_Rahmadi-Skripsi_STTC File folder
B Music doarman File folder
[&=] Pictures
B videos
% Local Disk (C:)
= Data (D)
L < >

| I

v| | unitypackage (“.unitypackage)

File name: | vuforia-unity-6-2-10.unitypackage

aau Prefabs ¢
©L Al Conflicte

Materials  Auamented..

Gambar 4.30: Import Package Vuforia dan Marker
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Import Unity Package

Gambar 4.31: Import Package Vuforia

Import Unity Package

Gambar 4.32: Import Package Marker

Setelah berhasil mengimport kedua package tersebut, selanjut-
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nya bukalah folder Vuforia, kemudian buka folder Prefab. Anda
akan menemukan file bernama ARCamera dan ImageTarget, lalu
drag/tarik kedua file tersebut ke tab Hierarchy seperti gambar di-
bawabh ini.

=t Unity 2017.2.0f3 Personal (64bit) - Augmented Reality.unity - AR 1 - Android™ <DX11 on DX9 GPU>
File Edit MAscsete GameObject Component Wuforia Window Help

(O3 < || [

= Hierarchy # Scene
| creata «| EFET Shadad
¥ € Augmenled Realily* =
Main Camera
Directional Light
P ARCamera

3 Projecl
| Create 'l

YAssets |
¥ i EdiLor £S5l Smarkcrrain
» & Plugins * ARCam-zra

&8 Resources
b G StreamingAssets

Iy CloudRedggnition
CylinderTakget

¥ & Vuforia * ImageTargey
» G Editer i MultiTarget
il Funils U ObjectTarget

&l Materials OTEILR.euugniLiun
2= prefabs I UserDefinedTargetBullder

b &3 Resources i VirtualButton
® &3 Seripts g\l’ul\ﬂirk
&5 Shaders ] hf Word
& Textures ¥ L ARCamera.prefab

Gambar 4.33: Drag ARCamera dan ImageTarget

Selanjutnya klik ARCamera, lalu pada tab Inspector klik “Open
Vuforia configuration”.
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Inspector

| Create v| (o all

v €) Augmented Reality* &= w M [ARCamera |0
Main Camera Tag | Untagged t| Layer | Default
Directional Light Prefab | Select ] Revert ] Apply

ARCamera

¥ .~ Transform

ImageTarget s
Position X0 Y 0 20
Rotation X o Yo Z0
Scale x|l Y1 Z[1

egﬂudio Listener
"s ¥ vuforia Behaviour (Script)

crif @ VuforiaBehaviour
"8/8 Center Mode | FIRST_TARGET
" I Open Vuforia configuration
| |
¥ |G| @ Default Initialke

Script (- DefaultInitializationErrorHandler

’ Add Component

Gambar 4.34: Buka Pengaturan Vuforia

Kemudian salin seluruh kode License Key tadi yang telah Anda
buat.

License Manager » Augmented Reality

Aug mented Reality Edit Name Delete License Key

License Key Usage

Please copy the license key below into your app

Lhsjbwn/////ARRAGYMZNoIz1i kH3mPS5ChGMSPRe ZCLRAVS3NWT g
U4dObnWEECT IhEmQGtsmiVZ1wvUibXCykZNPEPgOfujeuwEfz+tZ0
rLAc4N0aaBlfN5ibskz3Z25cpIn8I2a¥uV1LOWe205CGEM1CE0MSk1
rlUFl1tFMkx704JqILryFlgTe fLv4vOgghUgwmrRs4mTS8Zjqy8KE
yE+iHiarNBGWVpoem+vYyJlGgyVgsr/PYwngrpyfl4gCmdy S PCcH
vT49bEwpcgEQCTuCiwLrICpEVSVXEGP3£f3yaB8qCq+WhVGFHTR/NQ
BzmOMExZDITCGo81lyjPCHi3jXvETj1d3iNh62ig3VIUFo+8DvsHVE
BY98c538YRnFulTh3r

Gambar 4.35: Salin Kode Lisensi

Anda akan melihat kolom App License Key pada tab Inspector,
kemudian Paste-kan License Key pada kolom tersebut.
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& Inspector =
E VuforiaConfiguration #*, S
| open |
¥ Vuforia
App License Key | Absjbvn/// AAAAGYMZNo]zikH3MPISChGMSPReZ |

|CLRkVS3Nw7 gU4d0obnWEEOTIhREMQGtsmivzlvlibX |
| CvkZNPfPaOfuibuwEfz +tZ0rLAcdNOaaBOfNSibskz37 |
Delayed Initialization e

Camera Device Mode | MODE_DEFAULT o

Max Simultaneous Tracked Imag 1

Max Simultaneous Tracked Objec 1

Load Object Targets on Detectior| |

Camera Direction | CAMERA_DEFAULT
Mirror Video Background | DEFAULT

¥ Digital Eyewear

Eyewear Type | Mone

Gambar 4.36: Paste/Sisipkan Kode Lisensi

Kemudian lihat pada Datasets yang berada dibawah kolom Li-

cense Key, beri ceklis pada kedua kolom tersebut.

© Inspector e

E vuforiaConfiguration Q@ >
| open |
¥ Vuforia
App License Key AbsijbwnS AAAAGYMZNDIZikH3MPYSChG |

'MSPReZCLRkWS3Nw7gU4dObnWEEOTIHEm |
| OGtsmiVZIvUibXCvkZNPfPaOfuibuwEfz+tZ0 |

Delayed Initialization -
Camera Device Mode | MODE_DEFAULT &l
Max Simultaneous Tracke:?l

Max Simultaneous Trackeql1

Load Object Targets on Del |

Camera Direction | CAMERA_DEFAULT
Mirror Video Background | DEFAULT

ar || 4

¥ Digital Eyewear

an

Eyewear Type [ Mane

Load ARmarker Database
Activate [

Gambar 4.37: Ceklis pada Dataset

Kemudian kembali ke tab Hierarchy, klik pada ImageTarget, lalu

pada tab Inspector Anda definisikan marker yang telah Anda buat

sebelumnya.
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‘= Hierarchy @ -= © Inspector ] .=
| Create | (GrAl : [ [ImageTarget | [ Static = =
v QAugmented Reality™* = T caaaed L (Default i)
Main Camera J 992 *) Layer Lbea B
Directional Light Prefab | Select ] Revert | Apply |
¥ .~ Transform G %
w Position x/o Iv[o 1zlo =i
Rotation X0 Yo 'zlo |
Scale X 200 EYEZU_D | z;_zuu |
¥ | ¥ Mesh Renderer L %,
» Lighting
> Materials
Dynamic Occluded
YEQImage Target Behaviour (Script) L %
Script ~AImageTargetBehaviour @
Type | Predefined i)
Database | ARmarker t]
Image Target | markerzoooo &
Width
Height %{
Preserve child size -
Enable Extended Tracking ||
Enable Smart Terrain L]
¥|&  Turn Off Behaviour (Script) &,
Script TurnoffBehaviour [olE
marker20000Material ———— . »

Gambar 4.38: Mengatur ImageTarget

Apabila ImageTarget terlalu besar, Anda dapat mengubah ukur-
an skala tersebut dengan mengatur Scale.

8 Inspector | B -=
& |ImageTarget | L] Static = 3
Tag | Untagged t| Layer | Default 4|
Prefab | Select | Revert [ Apply |

¥ .~ Transform

Position
Rotation
Scale _i"l"g_luu |2/100 ,

Gambar 4.39: Mengubah Skala ImageTarget

Selanjutnya lihatlah pada kolom Project di folder Assets lalu bu-
ka folder Editor, kemudian buka folder Vuforia > ImageTargetTe-
xture > ARmarker, maka Anda akan melihat file marker.
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ImageTargetTextures - ARmarker

| mdma-ker20000 scaled.ipa

Gambar 4.40: Tekstur Marker

Selanjutnya reset gambar tersebut agar marker dapat terlihat.
Lihat pada tab Inspector lalu pilih tanda gerigi pada pojok kanan
atas, kemudian klik Reset.

Gambar 4.41: Reset Tekstur Marker

Klik ImageTarget pada kolom Scene, maka gambar marker yang
telah Anda buat akan tampil pada Scene.
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Gambar 4.42: Marker Gambar Uang

Tahap selanjutnya yaitu membuat objek kubus, dengan cara klik
kanan pada ImageTarget kemudian pilih 3D Object, kemudian pi-
lih Cube.

“= Hierarchy
| Create "| ‘o All Y
¥ € Augmented Reality* =

Main Camera
Directional Light
F ARCamera

Copy

Paste

Rename

Duplicate

Delete

Select Prefab

Create Empty

30 Ubject » Lube

2D Object » Sphere -
EfMlecls ¥ Capsule H
Light > Cylinder

Mudio > Plane

Viden > Cinad

Ul ] Ragdoll...

Camera Terrain

Gambar 4.43: Membuat Objek 3D

Maka akan muncul sebuah kubus.
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Personal (64bit) - Augmented Reality.unity - AR 1- Android™ <DX11 on DX9 GPU>

File Edit Assets GemeObject Component Vuforiz Window Help

£ + Bl

‘= Hierarchy

v € Augmented Reality*
Main Camera
Directional Light

> ARCamera
¥ ImageTarget

@1 Project
| create - a
¥ i Favorites
All Materials
(© all Models
(© Al Prefabs
© Al Conflicted

'+ Assets » Editor » Vuforia » ImageTargetTextures » ARmarker
- marker20000_scaled

¥ G Assets
¥ (& Editor
¥ Gl Vuforia

[y =O R

Gambar 4.44: Objek 3D Kubus

Anda dapat mengatur ukuran Scale-nya dengan cara klik tools
yang tersedia dibawah menu Unity. Aturlah hingga pas sesuai ke-
butuhan Anda.

Augmented Reality.un Andreid* <DX11 on DX9 GPL>

Fle Edit Assets

(& & S [=]]oi
= zrehy
| Creare -| (GeAll )
"Qﬁuqmented Reality*
Main Camera
Directiena Light
b ARCamera
¥ Imeg="arget

Gambar 4.45: Mengatur Skala Objek 3D

Agar kubus yang telah Anda buat lebih menarik, tariklah gam-
bar(drag) ke kubus tersebut, maka akan tampil material gambar
uang menjadi 3D.
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< Unity 2017.2.0f3 Personal (64bit) - Augmented Reality.unity - AR 1 - Android® <DX11 on DX9 GPU>
File Edit Assets

FAEIEIFA =

# Scene
| Shaded

Component Vi Window Help

= Hierarchy
|create-| GeAl
v €} Augmented Reality* =
Main Camera
Directional Light

| Gizmos ~| (BrAT

» ARCamera
¥ ImageTargst
Cube

21 Project
| create 7|
¥ {Favorites

4 Assets » Editor »f Vuforia » ImageTargetTextures » ARmarker

CLAll Materials 5 Materials

L All Models ¥ ®markerz0000_scaled
(LAl Prefabs

L all Conflicted

¥ G Assets
¥ G Editor
¥ &= Vufaria
¥ Gl ImageTargetTex
== ARmarker

Gambar 4.46: Menambahkan Tekstur ke Objek 3D

Jangan lupa untuk menyimpan projek, dengan cara klik file pi-
lih save scene atau tekan tombol Ctrl+S.

=t Unity 2017.2.0f3 Personal (64bit) - Augmyg

File Edit Assets GameObject Compc

Mew S5cene Ctrl+M
Open Scene Ctrl+0
Save Scenes Ctrl+S
Save Scene as... Ctrl+5hift+5
Mew Project...

Open Project...
Save Project

Build Settings... Ctrl+5hift+B
Build & Run Ctrl+B
Exit

Gambar 4.47: Menyimpan Scene
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Sebelum Anda build menjadi aplikasi Android, uji coba dahulu
dengan menekan tombol Play pada Unity kemudian arahkan uang
atau gambar yang Anda gunakan sebagai marker tadi ke kamera.
Pastikan gambar yang Anda buat saat mendaftar Vuforia sama de-
ngan yang Anda scan, apabila berhasil maka akan tampil objek 3D
pada uang atau gambar yang telah Anda buat.

Sebagai catatan Laptop atau PC anda memiliki Webcam.

ented Reality.unity - AR 1 - Android <DX11 on DX9 GPU=>
sonent  Vuforia Window Help

Gambar 4.48: Uji Coba Aplikasi
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Kemudian pilih menu File > Build Setting.

<t Unity 2017.2.0f3 Personal (64bit) - Augme

File Edit Assets GameObject Compo

Mew Scene Ctrl+ M
Open Scene Ctrl+0
Save Scenes Ctrl+5
Save Scene as... Ctrl+5Shift+5
Mew Project..,

Open Project...
Save Project

Build Settings... Ctrl+Shift+B
Build & Run Ctrl+B

Exit

Gambar 4.49: Menu Build Setting

Klik tekan build, lalu berilah AR Uang 3D, kemudian save dan
tunggulah hingga proses membangun aplikasi selesai.

Organize v New folder B - (7]
B This PC A Name Date modified Type
[ Desktop buku AR File folder
@ Documents Model 30 jadi File folder
* e 3dsmax File folder
Hadi_Rahmadi-Skripsi_STTC File folder
J! Music :
docrman File folder
[&] Pictures
B videos
i Local Disk (C:)
- Data (Dv)
d Network o %
File nare: | AR Uang 3D.apk w
Save as tyge: | apk (*.apk) ~
n e Fodes Conce
Ll
';‘ Xbox One Compression Method
SDKs for App Stores
PS Vita
ml Hiaomi Mi Game Center ‘
—ra PS4
sl |3 . L Unity Cloud Build
[ Switch Platform ][P\ayer Settiﬂqs‘..] I Build ] Build And Run

Gambar 4.50: Menyimpan Aplikasi
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Setelah proses membangun aplikasi selesai, maka Anda akan
mendapatkan sebuah file dengan format .Apk, lalu salinlah(copy)
file tersebut ke Handphone Android Anda kemudian instal.

l E l = | Compressed

Home Share View

» g2 X

w-l Copy path

Pinto Quick Copy Paste - Move Copy Delete
access d Paste shortcut to to -
Clipboard Crganize
©« v » ThisPC » Downloads » Compressed
-

3 Quick access

[ Desktop -+
; Downloads b 4
@ Documents o

AR Uang 3D.apk

Gambar 4.51: Menyalin Aplikasi ke HP Android

Setelah itu bukalah file manager pada Handphone Anda, kemu-
dian instal Aplikasi yang telah di Copy tersebut.

0.4K/s T R 1V 46 e 65%

Internal stor... Q

&} >root sdcard 55
ABSTRAKS...BAB 1,docx
07/16/17 23231 23,40 KB
AR Uang 3D.apk
10/19/17 1446 17,81 MB

B Bahan-baha...eak(1),zip
10/03/17 20523 5,56 MB

btsnoop_hc...000002617
01/01/15 07;00 6,29 KB

btsnoop_hc...000008995
08/217/17 07359 49.89 KB
Cara Hacke...bsite.docx
08/09/1716:33 63,41 KB

ﬁ Cara Mudah...ackeroﬁ
08/09/1716:35 B

Gambar 4.52: File Aplikasi AR
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Apabila menemui instalasi blocked atau pemasangan dicekal,
maka masuk ke Setting atau Setelan terlebih dahulu.

1450 - a @ > - Q3 0,0K/s > RS 46 T 64%

&

Cancel Settings

Gambar 4.53: Pemasangan dicekal

Beri cek box pada Unknown Sources.

450w M@ > - QAW 0,0K/s T U 11U 4G Tm 64%

DEVICE ADMINISTRATION

Device administrators
View or deactivate device administrators

Unknown Sources
Allow installation of apps from EI
unknown sources

Location >

Notification 6 apps can read
access notifications

Apps with usage access >

CREDENTIAL STORAGE

Storage type

Hardware-backed

Gambar 4.54: Beri Cek pada Unknown Sources

74



Membuat Aplikasi Augmented Reality Sederhana

Setelah itu jalankan instalasi kembali, dan tunggulah hingga pro-
sess instalasi selesai.

a7y
<

AR Uang 3D
Install this app?

SourcesFile Manager
Version:1,0

Permissions

Cancel Install

Gambar 4.55: Instal Aplikasi

Kemudian jalankan aplikasi, dan arahkan kamera ke marker uang
atau gambar yang Anda buat. Pastikan gambar yang Anda buat sa-
at mendaftar Vuforia sama dengan yang Anda scan. Maka aplikasi
akan menampilkan objek 3D yang telah Anda buat.

Gambar 4.56: Menjalankan Aplikasi
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i D

Membuat Model 3 Dimensi
dengan SketchUp

Pembahasan kali ini akan dijelaskan cara instalasi software Ske-
tchUp dan cara menggunakannya. SketchUp adalah sebuah per-
angkat lunak desain grafis yang dikembangkan oleh Trimble. Pen-
desain grafis ini dapat digunakan untuk membuat berbagai jenis
model, dan model yang dibuat dapat diletakkan di Google Earth
atau dipamerkan di 3D Warehouse.

Anda dapat mendownload versi gratisnya yang memiliki jangka
waktu trial selama 30 hari di

https://www.sketchup.com/download

Kemudian silahkan register terlebih dahulu. Setelah semua ko-
lom di isi selanjutnya klik tombol Download SketchUp.
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& > O B skerchupcomdownioad ® 0| =

To see favorites here, select ¥ then %, and drag to the Favorites Bar folder. Or import from another browser. Import favorites

= SketchUp
SketchUp Make SketchUp Pro

I

& Step 2: Tell us a bit about yourself

Educational Use v
= ‘ I ‘ comet.mca@gmail.com

L O Send me SketchUp news and tips
comet mea
sttc
Student v
Windows v

SketchUp Pro 2017 v

B3 | agree to SketchUp Pro’

Gambar 5.1: Registrasi pada Website SketchUp

Jika Anda ingin membeli versi Pro, Anda pun dapat membelinya
dengan harga 695 USD.

& > X | A sketchupcomdounioadssketchup-propwindows/thank-you 2% ¥ ¢

To see favorites here, select ¥ then ¥, and drag to the Favorites Bar folder. Or import from another browser. Import favorites

= SketchUp

Thank you for downloading SketchUp Pro Buy SketchUp Pro

Try out SketchUp Pro for 30 days. Then buy alicense that never expires. Upgrade an existing license:

& Installing SketchUp on your PC

Gambar 5.2: SketchUp Pro
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5.1 Instalasi SketchUp

Setelah berhasil mengundubh file installer, jalankan installer yang
telah Anda unduh. Kemudian ikuti langkah di bawah ini.

2

SketchUpPro-
en-xbd.exe

Gambar 5.3: File SketchUp Hasil Unduh

Kemudian tekan Next.

i'—? SketchUp Pro 2017 (64-bit) Setup

Welcome to the SketchUp Pro 2017
(64-bit) Setup Wizard

The Setup Wizard allows you to change the way SketchUp
Pro 2017 (64-bit) features are installed on your computer or
to remowe it from your computer. Click Mext to continue or
Cancel to exit the Setup Wizard.

- =

Gambar 5.4: Instal SketchUp

Jika Anda ingin merubah lokasi instalasi silahkan klik Change,
Anda dapat mengklik change untuk menentukan pemilihan lokasi
yang lainnya, setelah itu klik Next.
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jie SketchUp Pro 2017 (64-bit) Setup
Destination Folder

Click Next to install to the default Foiaer or dick Change
N S

Install SketchUp Pro 2017 (64-hit) to:

IC:‘Program Files\SketchUp\SketchUp 2017

Change...

Gambar 5.5: Destinasi Folder

Setelah instalasi selesai maka klik Finish.

jig SketchUp Pro 2017 (64-bit) Setup

Completed the SketchUp Pro 2017 '
(64-bit) Setup Wizard l

Click the Finish button to exit the Setup Wizard.

Back Finish Cancel

Gambar 5.6: Instalasi Komplit

Selanjutnya Anda dapat menjalankan program SketchUp, de-
ngan mengklik shortcut seperti gambar dibawah ini.
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tchlp

Gambar 5.7: Menjalankan SketchUp

Kemudian beri ceklis pada box : I agree to the SketchUp License
Agreement”.

SketchUp License Agreement

SOFTWARE END USER LICENSE AGREEMENT (Trimble "
SketchUp)

IMPORTANT, READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING OR
USING ALL OR ANY PORTION OF THE SOFTWARE, YOU ARE ACCEPTING ALL OF THE
TERMS AND CONDITIONS OF THIS AGREEMENT. ¥YOU AGREE THAT THIS AGREEMENT IS
ENFORCEABLE LIKE ANY WRITTEN AGREEMENT

IF YOU DO NOT AGREE TO ALL OF THESE TERMS AND CONDITIONS, DO NOT USE OR
ACCESS THE SOFTWARE. IF YOU HAVE PAID A LICENSE FEE FOR USE OF THE SOFTWARE
AND DO NOT AGREE TO THESE TERMS, YOU MAY RETURN THE SOFTWARE FOR A FULL
REFUND, PROVIDED YOU (A) DO NOT USE THE SOFTWARE AND (B) RETURN THE
SOFTWARE WITHIN THIRTY (30) DAYS OF YOUR INITIAL PURCHASE.

BY AGREEING TO THESE TERMS AND CONDITIONS, YOU REPRESENT THAT YOU ARE 18
YEARS OLD OR OLDER AND CAPABLE OF ENTERING INTO A LEGALLY BINDING
AGREEMENT

IF ¥YOU WISH TO USE THE SOFTWARE AS AN EMPLOYEE, CONTRACTOR, OR AGENT OF A
CORPORATION, PARTNERSHIP OR SIMILAR ENTITY, THEN YOU MUST BE AUTHORIZED TO
SIGN FOR AND BIND THE ENTITY IN ORDER TO ACCEPT THE TERMS OF THIS AGREEMENT.
THE LICENSES GRANTED UNDER THIS AGREEMENT ARE EXPRESSLY CONDITIONED UPON
ACCEPTANCE BY SUCH AUTHORIZED PERSONNEL.

If an executed agreement exists between you and Trimble at any time regarding the Software. the

terms of that agreement shall supersede the terms of this Agreement in its entirety. Thus, if you enter
into a separate written agreement with Trimble regarding the Software, that agreement (not this one)

will control your use of the Software; and further if that agreement is terminated, you will not have the v
right to use the Software under the terms of this Agreement after termination.

¥ Iagree to the SketchUp License Agreement Continue I Exit |

Gambar 5.8: Persetujuan Lisensi

Selanjutnya klik “Start using SketchUp”.
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& Trimble.

T
Licensed To: SketchUp Pro ml?Tnammgmg

Default Template: No Default Template

r SketchUp skills

Up Buy SketchUp Pro

Gambar 5.9: Membuat Projek Baru SketchUp

Tunggulah beberapa saat, maka akan tampil jendela SketchUp.

eSS H L EB b zLH OB R

L = -
F

» BEEEEEE

Select Tool
Select entities to modify when
using other tools or commands.

Tool Operation
1. Click on an entity

@ ® @ | Select objects. Shiftto extend select. Drag mouse to select multiple. | Measurements ]

Gambar 5.10: Jendela SketchUp

Langkah selanjutnya yaitu mencari model 3D jadi, yang sudah
banyak tersedia pada 3D Warehouse. Klik pada menu File lalu pilih
3D Warehouse dan pilih Get Models.
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= Untitled - SketchUp Pro 2017 (15 days left in TRIAL)
| File Edit View Camera Draw Tools Window Help

New Ctel+N v| 6 ',3) @ a

Open... Ctrl+ O

Save Ctrl+5
Save As...

Save A Copy As...

Save As Template...

Revert

Send to LayOut...

Geo-location

Trimble Connect Share Model...

Import.
Export »

Gambar 5.11: Mencari Model 3D

Maka akan tersedia model 3D yang sudah jadi dan siap pakai,
pilihlah salah satu model 3D yang Anda inginkan.

son -

e blanche H 48 cm EMMA, 155129, 4999 € Lbl

L]
WIELE 5seim

fashion of kitchens

® opendesk A

Greenbuild

- Thermastrand Radiant Barrier Roof S, ﬁ
|

® o B2

@ @ @ | Select objedts. Shift to extend select. Drag mouse to select multiple. | Me

Gambar 5.12: 3D Warehouse

Kemudian klik Download, lalu klik Yes.
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@ 3D Warehouse - [m] b o
IR
SoarHouse © I

Add ta Collection

N b
Load Into Model?
Downloads 181822
@ Load this directly into your SketchUp model? kes Rl
.skp File Size 29MB
Polygons 7449
Materials
Components 1
Uploaded 4124110
Last Modified 3nan4
Share <> Embed

& f ¥ @

o

e home, it ot s
ce. The ‘a Paulwall -

tradi ents
features 3 bedrooms,

Gambar 5.13: Mengunduh Model 3D

Setelah berhasil mengunduh, maka objek 3D akan tampil pada
jendela SketchUp. Kemudian hapus model manusia dengan cara
klik kanan pada objek tesebut lalu pilih Erase.

Tools Window Help

WAL MR- LY TR

p
File Edit View Camer

@ @ | Erase the selected entities from the model. | Me

Gambar 5.14: Berhasil Mengunduh Model 3D

Anda bisa menambahkan model 3D lainnya yang Anda ingink-
an seperti Pohon, Tanaman, dll. Dengan cara mengunduh dari 3D
Warehouse.
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Gambar 5.15: Mengunduh Model 3D Pohon

Kemudian letakan model 3D tersebut sesuai kreasi yang Anda
inginkan. Anda juga bisa menyalin model 3D tersebut tanpa perlu
mengunduh lagi, dengan cara klik Ctrl+C kemudian Ctrl+V, apabila
berhasil maka akan tampil model 3D lagi yang telah Anda salin.

Gambar 5.16: Menyalin Model 3D

Setelah desain 3D yang Anda buat selesai, langkah selanjutnya
yaitu Export model 3D, dengan cara klik menu File kemudian pilih
Export lalu pilih 3D Model.
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T Untitled - SketchUp Pro 2017 (15 days left in TRIAL)

File | Edit VYiew Camera Draw
MNew

Open...

Save

Save As...

Save A Copy As...
Save As Ternplate...
Rewvert

Send to LayOut...

Geo-location
3D Warehouse
Trimble Connect

Ctrl+N
Ctrl+ O

Tools  Window Help

ME G K XS

Ctrl+5

Import...
Print Setus... 2D Graphic...

Gambar 5.17: Export Model 3D

Simpan model 3D tersebut dengan nama yang Anda inginkan,

kemudian klik menu Options terlebih dahulu dan ubah pengatu-

rannya seperti pada gambar dibawah ini.

FBX Export Options
B Export Model
Geometry
&« ~ 4 || » ThisPC » Data(D:) > AR Rumak
Organize * Mew folder I Trianguiate all faces
= ¥ Export two-sided faces
~
B Desktop hame I Separate disconnected faces
Documents
& Downloads Materils
: |V Export texture maps
J’ Music
[&] Pictures Scale
B videos ¥ Swap YZ coordinates (Y is up)
i Local Disk (C:) Units:  (Model Units -
= Data (D:)
= o | e
v < >
File namé | Model Rumah.fbx ~
Save as typg | FBX File (*.flbx) W
i Fritiers | optons.. ||| Bpot || concel

Gambar 5.18: Pengaturan Export

Apabila telah selesai, kemudian klik Export. Setelah berhasil
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mengeksport model 3D maka akan tampil popup, selanjutnya klik
OK.

FBX Export Results

Sketchlp Entities processed:

32 Groups

47 Instances
22017 Faces
38 Materials
23 Textures

FBX Entities exported:
105102 Faces

38 Materials
23 Textures

0K

Gambar 5.19: Berhasil Export Model 3D

File model 3D yang telah berhasil di eksport memiliki format
file .fbx beserta folder tesktur model tersebut. Langkah selanjutnya
yaitu membuat aplikasi.

| B

Maodel Model
Rumah Rumah.fbx

Gambar 5.20: File Model 3D dan Teksturnya
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5.2 Tahap Pembuatan Aplikasi

Pertama buka website Vuforia, kemudian login dengan akun yang
telah Anda buat sebelumnya.

s vuforia- peveloper Portal

Home Pricing Downloads Library Develop Support

Login

Email Address
comet.mca@gmail.com

Not Registered? Create account now

Password

000000 ® i

Forgot password?

Gambar 5.21: Login Vuforia

Setelah berhasil login, kemudian pilih Develop lalu pilih Target
Manager, maka akan tampil database yang telah Anda buat sebe-
lumnya. Klik pada database ARmarker tersebut.

)

Q vuforia” beveloper Portal Hello Hadig3 ~ | Log Out

Home Pricing Downloads Library Develop Support

License Manager Target Manager

Target Manager

Use the Target Manager to create and manage databases and targets.
Add Database

Database Type Targets Date Modified

Device 2 Oct 19, 2017 12206

Gambar 5.22: Target Manager
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Kemudian tambahkan target marker baru, dengan cara klik Add

Target.

s vuforia™ peveloper Portal Hello Hadi3 ~ | Log Out

Home Pricing Downloads Library Develop Support

License Manager ~ Target Manager
Target Manager » ARmarker

ARmarker esitnane

Type: Device
Targets (2)
Dowriesd Database G4
O Target Name Type Rating Status v Date Modified
v
a , | marker20000 Single Image Active Oct 19, 2017 12:08
o Marker50000 Single Image Active Oct 19,2017 12:04

Gambar 5.23: Menambahkan Target

Maka akan tampil popup, lalu browse dimana Anda menyimp-
an gambar yang akan dibuat menjadi marker. Ubah ukuran Width
menjadi 500, dan beri nama marker lalu klik Add.

Add Target
Type:
Single Image Cuboid Cylinder 3D Object
File:
§ Browse_
jpgor png (max fils 2mb)

Width
.
er the width of your target in scene units. The size of the target should be on the

same scale as your augmented virtual content. Vuforia uses meters as the default unit
scale. The target's height will be calculated when you upload your image.

| MarkerRumput

e
will be reported in the APL

base. When a target is detected in your application, this

Cancel Add

Gambar 5.24: Upload Gambar Marker
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Marker yang dipilih bergambar rumput menyesuaikan dengan
model 3D yang tadi telah dibuat, karena model 3D akan tampil di-
atas marker.

Dengan catatan gambar yang akan dibuat marker, harus jelas
gambarnya dan memiliki format file .jpg atau .png dengan ukuran
file tidak lebih dari 2mb.

Gambar 5.25: Gambar Marker Rumput

Rating harus memiliki minimal 3 bintang agar saat scan nanti
marker mudah dibaca oleh kamera. Setelah berhasil mengupload
gambar marker, kemudian beri ceklis pada box marker yang telah
Anda buat tadi, lalu klik Download Database tersebut.

s vuforia- peveloper Portal Hello HadiB3 ~ | Log Out

Home  Pricing  Downloads  Library ~ Develop  Support
License Manager  Target Manager

Target Manager > ARmarker

ARmarker et
Type: Device

Targets (3)

Add Target Download Database (1)

O Target Name Type Rating Status v Date Modified

tselected  Delete

Single Image Active Oct 21, 2017 1134

"
o g§ marker20000 Single Image Active Oct 19, 2017 1206

0 [} Merkersoooo Single Image Active Oct 19, 2017 1204

Gambar 5.26: Mengunduh Database Marker
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Lalu akan muncul popup Download Database, pilihlah platform
Unity Editor kemudian klik Download.

Download Database

1 of 3 active targets will be downloaded

Name:
ARmarker

Select a development platform:

-:::.Android Studio, Xcode or Visual Studio
{@} Unity Editor

Cancel Download

Gambar 5.27: Memilih Platform Database Marker

Setelah berhasil mengunduh, maka Anda akan mendapatkan
file package marker, dengan format .unitypackage.

=

ARmarker.unit
ypackage

Gambar 5.28: Berhasil Unduh Marker

5.2.1 Membuat Projek Baru Unity

Setelah semua file yang dibutuhkan telah di Unduh, maka Anda
bisa melanjutkan ke tahap selanjutnya, pilih New pada Unity.
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<4 Unity 2017.2.013

Projects  Learn 3 new | [ open
On Disk AR1

Path: C\Users\Comet\Documents | Unity version: 2017.2.0
In the Cloud

ARtes 1

Path: C:\Users\Comet\Documents | Unity version: 5.6.2p2

Gambar 5.29: Membuat Projek Baru

Lalu berilah nama projek tersebut sesuai keinginan Anda, ke-
mudian klik Create projects.

<4 Unity 2017.2.0f3

Projects  Learn [ new [ open

‘ AR Rumah

C:\Users\Comet\Documents

® 3D () 2D | AddAsset Package
g

Gambar 5.30: Memberi Nama Projek

Lalu Import package Vuforia terlebih dahulu yang telah Anda
unduh di subbab sebelumnya.
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vuforia-unity-6
-2-10.unitypac
kage

Gambar 5.31: Package Vuforia

Pilih menu Assets kemudian pada Import Package klik Custom

Package.

Assets  GameObject Compenent  Window  Help

Create ]
Show in Explorer

Open

Delete

Open 5cene Additive

Import Mew Asset...
Import Package ¥ Custom Package...
Export Package... 0
Find References In Scene
Cameras
Select Dependencies Characlers
Refresh Ctrl+R CrossPlatforminput
Reimport Effects
Reimport All Envircnment
ParticleSystems
Extract From Prefab Pentiking
Run APl Updater... Utility

Open C# Project Vehicles

Gambar 5.32: Menu Import Package

Kemudian Import Vuforia package lalu klik Open.
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File

Edit

Assets

GameObject Component Window Help

saclie |

3t Import package ...

4+ B> ThisPC » Desktop v O Search Desktop pel
Organize v Mew folder B ™ @
Video o] Name Date modified Type
OneDlrive Q vuforia-unity-6-2-10.unitypackage 10, 19/2017 1:19PM  Unity package file
— . 10, 19/2017 12:06 ... Unity package file
= hEE buku AR W/16/20177:35PM  File folder
I Desktop Model 3D jadi File folder
Documents 3dsmax File folder
‘ Downloads Hadi_Rahmadi-Skripsi_STTC 10/14 File folder
J», Music doorman 2/26/2013 10:07 PM  File folder
[&] Pictures
B videos
. Local Disk (C1)
= Data (D:)
e e ff2

File name: |vuforia-unity-6-2-10.unitypackage

~ | | unitypackage (;'.uni‘typacix;_g-ei-Ti

| Open Cancel |

Gambar 5.33: Mencari Letak Penyimpanan Vuforia Package

 Import Unity Package x

vuforia-unity-6-2-10

|
i

¥ |§|Iicense_:!rdpar‘tynntice.txt [MEH I
™ [ link.xm [ NEW]
b4 EﬁPlugins
v Eﬁﬁmdroid
¥ [ Androidmanifest.xml
v M SHlibs
v gﬁarmeabi-v?a
¥ [ libvuforiase
¥ | |libvufariaUnityPlayer.so
o Dlib\i’ufnria'ﬂrapper.su el
v Eﬁsrc
v gﬁcom
¥ o 5 vuforia
v EﬁVuforiaUnit\rPla\rer
v DDebugLng.java [NEW]
¥ [T orientationUtility java  GZEd k:
frer i R ; m_i
e

Gambar 5.34: Import Vuforia Package
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Jika ada peringatan seperti gambar dibawah ini, maka klik “I
Made a Backup, Go Ahead!”.

AP| Update Required x

This project contains scripts and/for assemblies that use
obsolete APIs,

If you choose 'Go Ahead', Unity will automatically
upgrade any scriptsfassemblies in the Assets folder
found using the old APIs. You should make a backup
before proceeding.

(fou can always run the API Updater manually via the
‘Assets/Run API Updater' menu command.)

| I Made a Backup. Go Ahead! | | Mo Thanks |

Gambar 5.35: Peringatan Update API

Kemudian Import/Tarik file marker yang telah Anda buat dan
model 3D beserta folder teksturnya yang telah Anda unduh sebe-
lumnya, lalu tekan Import.

= Scene © Inspector
| Shaded +|[=o] % [ <] & | Gizmos -| GrAll | 3 Obiects
\” Narrow the Selection:
-
o ["]2 Folders

wl Game Object

B B - | ARRumah

Home Share

View

v 4 s Tiniad P T
A
# Quick access -
[ Desktop b4 @
‘ Downloads  # —
Documents odel Rumal marker.unit odel
F% " b Z % ] Model Rumah  ARmarker.uni Model
g - ) = ’ p . W = _ypa.:kage Rumah.fbx

23 Project

| crests -|
Al Models

@AII Prefabs
©1 all Conflict

v & Editor . - - -

Materials
(& Model Rum ey
¥ &5 Vuforia

b &3 Plugins Noguagas Heguagem Segueam
aiguanoe
&5l Resources g oprasin
» &5 StreamingAss.

¥ & Vuforia ¥| B Model Rumah

buku AR

items selected

Plugins Resources StreamingAsse.. Wufaria

Asset Labels

AssetBundle  [Tane

Gambar 5.36: Import Asset
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Import Unity Package %

I ARmarker

v ™ & Editar
v | S5 vuforia
¥ EﬁlmageTargetTe)(tures
v G35 ARmarker
[+ || MarkerRumput_scaled.jpg [ovee
v & StreamingAssets
v o vuforia
I [kl AR marker.dat ———
M [ ARmarker.xml —

Gambar 5.37: Import Marker

Setelah berhasil mengimport package dan model 3D tersebut,
selanjutnya bukalah folder Vuforia, kemudian buka folder Prefab.
Anda akan menemukan file bernama ARCamera dan ImageTarget,
lalu tariklah kedua file tersebut ke tab Hierarchy seperti gambar
dibawah ini.

<120 ] % | <) [ |

Gambar 5.38: Drag ARCamera dan ImageTarget

Hapuslah Main Camera karena kamera yang digunakan adalah
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ARCamera.

<t Unity 2017.2.0f3 Personal (64bit) - Untitled
File Edit Assets GameObject Compor

O Rl S | = Bl [tcente

= Hierarchy

| Create "'l (o All Y

Main Camera

b ARCamera
ImageTarget

Gambar 5.39: Hapus Main Camera

Selanjutnya klik ARCamera, lalu pada tab Inspector klik “Open
Vuforia configuration”.

Personal (64bit) - Untitle
eObject Compt

mua-- (S coleb 1 (& ] [account -] [tovers -] [avoue -]
= Hierarchy ® Inspector

|(: ate 7| (oAl & [ARCamera

¥ & untitled* Tag | Untagged +| Layer [ Default ™|

% s ] 7 et
¥ .~ Transform =
Position X0 Yo Z0
Rotation X0 Yo Z0

| [] static = |

Seript Defau\t[mtlahzatlonErrorHandIer 7\ o]

[ Add Component l

Gambar 5.40: Pengaturan Vuforia

Anda akan melihat kolom App License Key pada tab Inspector,
salinlah kemudian Paste-kan License Key yang telah Anda buat pa-
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da kolom tersebut. Kemudian lihat pada Datasets yang berada di-
bawah kolom License Key, beri ceklis pada kedua kolom tersebut.

License Manager » Augmented Reality
AugmentEd Reallty Edit Name Delete License Key

License Keay Usage

Please copy the license key below into your app

Absjbvn/////BAARAGYMINCIzikH3mP 95ChGMSPRe ZCLEKVS3NwTg
U4dCbnWEEOT1hEmQGtsmiVZ1vUibXCykZNPEfPgOfuj6uwEfz+L 20
rLAcd4N02aB0fN53ibskz3Z50pIn8TI2aYuV1LOWGe20SCOM1ICEOMS k1
rlUFltFMkx7Q4JgILryFlgTefLvdvOgghUgwmrRs4mTS8Zjgy8RE
yE+iHiarNBEGWVpcbm+vYyJTlGqyValr/FYwngrpyfl4gCmdyBPCc
vT749bEwpcgEQCTuCiwLr ICpEVSVXEGP3£3yaBqCqtWhVGFHTR/NQ
8zmOMfxZDITColly jPCHi3jXvETj1d3iNh62igiV2UFo+8DvsHVp
B98c58¥RnFulTh3r

Gambar 5.41: Menyalin Kode Lisensi

@ Inspector ._ - =
VuforiaConfiguration B £~
| ©pen |
¥ Vuforia
App License Key | Absjbvn////fAAAAGYMZNolzikHIMPISChGM |

|SPReZCLRkVS3NWTgU4dObnWEEOTIHEMQGt
smiVZIvUibXCvk ZNPFPaOfuieuwEfz+tZ0rLAD |
Delayed Initialization

Camera Device Mode | MODE_DEFAULT L]
Max Simultaneous Tracked 1

Max Simultaneous Tracked 1
Load Object Targets on Deil |
Camera Direction | CAMERA_DEFAULT ol

Mirrar Video Background [ DEFAULT =

¥ Digital Eyewear

Eyewear Type | Mane il

Y Datasets
Load ARmarker Database [«
Activate ™)

Gambar 5.42: Ceklis pada Datasets

Kemudian kembali ke tab Hierarchy, klik pada ImageTarget, lalu
pada tab Inspector Anda definisikan marker yang telah Anda buat
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sebelumnya. Apabila ImageTarget terlalu besar, Anda dapat meng-
ubah Scale tersebut.

= Hierarchy 252 © Inspector | R
| create ~| (@rAll ] B [[TageTaraet Tl =~
v i * =
Ql..lnht.led = Tag | Untagged 4+ | Layer | Default ™
Directional Light
Ap o Prefab | Select | Revert ] Apply |
ImégeTarget ¥ .~ Transform @ #
Position Xo | ¥i{0 Z0 |
Rotation X0 ‘Yo z'o |
Scale X500 | Y500 Z /500 |
¥ | ¥ Mesh Renderer #,
» Lighting
» Materials
Dynamic Occluded [
Yalmage Target Behaviour (Script) 3,
Script ~EImageTargetBehaviour o]
safiscahiimte — [
Database | ARmarker ™
Image Target [ MarkerRumput t]
; 1
e |
Height (375 |
Preserve child size L]
Enable Extended Tracking [ |
Enable Smart Terrain -
¥[  Turn Off Behaviour (Script) o,
Script TurnOffBehaviour Qv

Gambar 5.43: Load Database Marker

Selanjutnya Anda lihat pada kolom Project lalu buka folder As-
sets > Editor > Vuforia > ImageTargetTexture, maka Anda akan me-
lihat file marker.

Selanjutnya reset gambar tersebut agar marker dapat terlihat.
Lihat pada tab Inspector lalu pilih tanda bulat panah pada pojok-
an, kemudian klik Reset maka tekstur marker akan tampil.

99



Membuat Model 3 Dimensi dengan SketchUp

© Inspector
MarkerRumput_scaled Import Sattings

| Shaded

L
Texture Type Default 0
Texture Shape 20 g
sRGB (Color Texture) 7
Alpha Source [ Input Texture Alpha 4]
Alpha Is Transparsney -

----- d
Wrap Mode Repeat .
Filter Mode Bilinear - ]
e ——

Defaul: [ENE)
Max Size (2048 fl
Resize Algorithm Mitchell .
Compression Hormal Quality. :
Format Auto =
Use Crunch Compression =
docly

Jforia - ImageTargetTextures »

©1 All Conflicted

MarkerRumput_scaled

¥ Gl Assets
v & Editor
v & vuferia

diDXTL 170.7 KB

Gambar 5.44: Reset Gambar Marker

Kemudian drag atau tarik model 3D rumah atau model yang te-
lah Anda buat ke ImageTarget.

!
LAl prefabs
(O All Conflicted

Gambar 5.45: Tarik Model 3D ke Hierarchy

Bila model 3D terlalu besar, Anda dapat merubahnya dengan
mengatur skala pada tab Inspector, lalu letakan model 3D pas dia-
tas marker, sepert gambar dibawah ini.
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ale ¥ 2
Add Component

Gambar 5.46: Ubah Skala Model 3D

5.2.2 Uji Coba Aplikasi

Sebelum Anda build menjadi aplikasi Android, uji coba dahulu apli-
kasi tersebut dengan menekan tombol Play pada Unity kemudian
arahkan uang atau gambar yang Anda gunakan sebagai marker ta-
di ke kamera.

Pastikan gambar yang Anda buat saat mendaftar Vuforia sama
dengan yang Anda scan, apabila berhasil maka akan tampil objek

3D pada uang atau gambar yang telah Anda buat.

Sebagai catatan Laptop atau PC anda memiliki Webcam.
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- AR Rumah - PC, Mac & Linux Standalone® <DX11>

went  Vuforia Window Help

Gambar 5.47: Uji Coba Aplikasi

Kemudian apabila telah berhasil berjalan, klik tombol Play tadi
lalu pilih menu File > Build Setting.

< Unity 2017.2.0f3 Personal (84bit) - Untitleg

File  Edit Assets GameObject Compe

Mew Scene Ctrl+M
Open 5cene Ctrl+0
Save Scenes Ctrl+5
Save Scene as... Ctrl+Shift+5
MNew Project...

Open Project...

Save Project

Build & Run Lirl+B

Exit

Gambar 5.48: Menu Build Setting

Pilih Android lalu klik Switch Platform kemudian klik Player Set-
ting untuk mengatur nama aplikasi dan company.
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Gambar 5.49: Menu Build Setting Android

Berilah Product Name sesuai dengan nama aplikasi keinginan
Anda.

® Inspector

@ PlayerSettings

Gambar 5.50: Memberi Nama Aplikasi

Pada Tab Inspector, pilih Other Setting lalu ubah “Package Na-
me” dengan teks sesuai pada PlayerSettings contoh: com.hadi.arrumah
(tanpa ada spasi).
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3 | & E
i~
Settings for Android
| Resolution and Presentation |
| Icon |
| Splash Image |
Other Settings
Rendering
Color Space* | Gamma al
Auto Graphics APT (]
Graphics APLs
— OpenGLES2
Tl =
Multithreaded Rendering™ &
Static Batching [
Dynamic Batching ¥4
GPU Skinning* (]
Graphics Jobs (Experimer[_|
Virtual Reality moved to XR Settings
Protect Graphics Memaory [
Identification
Package Name com.hadi.arrumah
Version™ 1.0
Bundle Version Code 1
Minimum API Level | Android 4.1 ‘Jelly Bean' (API level 16) |
Target API Level [Autumitlc (highest installed) :]
Configuration 4
v

Gambar 5.51: Package Name

Selanjutnya klik Build kemudian beri nama aplikasi Anda dan
Save lalu tunggulah hingga proses membangun aplikasi selesai.
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| < Build Android *
<« v A » ThisPC » Data(D:) » ARRumah » v O Search AR Rumah pel

Organize + Mew folder B== o

~ & ;
[ This PC MName Date modified Type

[ Desktop Model Rumah 10/21/2017 10:30 ... File folder
E| Documents

‘ Downloads

J‘! Music

[&] Pictures

B videos

=5 Local Disk (C:)

- Data (0]

|_j Metwork

e

File namg: | AR Rumah|

Save as typlk: |apk (*.apk)

A Hide Folders Cancel
@ SDKs for App Stores
PS \ita I
ml Xiaomi Mi Game Center | Add |
Eirel el
it il

Learn about Unity Cloud Build

Aulld

| Switch Flatfarm HPIayer Settings... ][ IBuiId And Run ]

Gambar 5.52: Menyimpan Aplikasi

Setelah proses membangun aplikasi selesai, maka Anda akan
mendapatkan sebuah file dengan format .Apk, lalu salinlah(copy)
file tersebut ke Handphone Android Anda kemudian instal.

AR Rurmnah.apk
Gambar 5.53: Aplikasi yang Telah Berhasil Dibuat

Jangan lupa untuk menyimpan projek tersebut, dengan cara pi-
lih menu File lalu Save Scene atau klik Ctrl+S.
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=4 Unity 2017.2.03 Personal (B4bit) - Untitlg
File Edit Assets GameObject Compe

Mew Scene Ctrl+M
Open Scene Ctrl+Q
Save Scenes Ctrl+5
Save Scene as... Chrl+5Shift+5
Mew Project...

Open Project...
Save Project

Build Settings... Ctrl+Shift+B
Build & Run Ctrl+B
Exit

Gambar 5.54: Menyimpan Scene

Beri nama Scene tersebut, lalu Save.

<* Save Scene

+~ <« Documents » ARRumah » Assets » v O Search Assets 2
Organize New folder B (7]
B This PC [ Mame Date modified Type
I Desktop Editor 1072 11:57...  File folder
@ Fiocrarient= Materials File folder
Model Rumah File folder
3 Downloads
Plugins File folder
D Music f
. Resources File folder
] Pictures StreamingAssets File folder
B videos Vufaria 10/2 File folder
i Local Disk (C3)
- Data (D)
o Network o >
File name: | arrumah 55
Save as type: | unity (*.unity) &

~ Hide Folders Cancel

Gambar 5.55: Menyimpan Scene AR Rumah

Setelah itu bukalah file manager pada Handphone Anda, kemu-
dian instal Aplikasi yang telah di salin tersebut.
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GaK/s B BRI 4G i 5%

= Internalstor... Q

&} >root sdcard B8

AR Rumah,apk
10/21/1713:46 217,79 MB

AR Uang 3D.apk
10/19/1714:46 17,81 MB

B Bahan-baha...eak(1),zip
10/03/17 20523 5,56 MB
n btsnoop_hc...000002617

01/01/15 077:00 6,29 KB

btsnoop_hc...000008995
08/27/1707:59 49,89 KB

Cara Hacke...bsite,docx
08/09/1716:33 63,41 KB

ﬁ Cara Mudah...acker.ﬂ
08/09/1716:35 o B

Gambar 5.56: File Aplikasi AR

44K/s B RIS 4G T 65%

&

2

AR Rumah

Install this app?

Source:File Manager
Version:1,0

Permissions

Cancel Install

Gambar 5.57: Instal Aplikasi

Kemudian jalankan aplikasi, dan arahkan kamera ke marker rum-
put atau gambar yang Anda buat. Pastikan gambar yang Anda buat
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saat mendaftar Vuforia sama dengan yang Anda scan. Maka apa-
bila berhasil aplikasi akan menampilkan objek 3D yang telah Anda
buat.

Gambar 5.58: Menjalankan Aplikasi AR Rumah

5.2.3 Membuat Tombol Keluar Aplikasi

Setelah membuat Aplikasi Augmented Reality sebelumnya, mung-
kin Anda merasa ada yang kurang. Aplikasi yang telah dibuat se-
belumnya tidak ada tombol keluar/exit, yang mengharuskan An-
da menekan tombol Home pada Android jika ingin keluar/exit dari
Aplikasi.

Pada sub-bab ini, akan dijelaskan cara membuat tombol kelu-
ar dari aplikasi. Bukalah kembali projek “AR Rumah” yang sudah
Anda buat.
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4 Unity 2017.2.0F3.

Projects Bnew  [Hooen

0n Disk AR Rumal

In the Cloud

AR Rokok

Gambar 5.59: Membuka Projek AR Rumah

Kemudian klik menu Game, lalu ubah ukuran layar menjadi lan-
dscape, pilih WSVGA Landscape (1024x800).

H# Scene € Game | £ Asset Store 22 Animator
WEWGEA Landscape (1024ux€ +| Scale (& 0.54:
spect

e (Mot Connected) (10x10)
Portrait (320x480)
Landscape (480x320)
Portrait (480x800)
Landscape (800x480)

WSWVGA Landscape (1024x600)
A A D=t (2001 72000
WHXGA Landscape (1280x800)
3:2 Portrait (2:3)

3:2 Landscape (3:2)
16:10 Portrait (10:16)
16:10 Landscape (16:10)

o

Gambar 5.60: Ubah Ukuran Layar

Selanjutnya klik kanan pada tab Hierarchy lalu tambahkan Can-
vas, klik kanan pilih UI > Canvas.
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= Hierarchy # Scene

| Create Y| (G | shaded
v € arrumah* =
Directional Light
F ARCamera

P ImayeTaryel

Copy

Paste

Rename =

Duplicale age

Delete Raw Image
Button

Select Prefab Toggle

Create Empty Slider

30 Object > Scrollbar

2D Object > Dropdown

Effects > Input Field

Light ¥ Canvas

Audic 3 Panel

Video £ Scroll View —

ul > Event System

Camera I I 7 EUIte
&=l Materials

Gambar 5.61: Membuat Canvas

Setelah itu pada Canvas yang telah dibuat tambahkan Button,
klik kanan pada Canvas pilih UI > Button.

Hr Suene
Shadad

= Higrarchy

| ereare - | (AT D

v Q arrumah* =
Lirectional Light

P ARCamera

= TmagaTargat

EventSy Copy

Paste
Rename =
Duplicate hRa08
Delele Raw Image
Button
Select Prefab ezl
Create Empty Slider
30 Object > Scrollbar
2D Object > Dropdown
Effects > Input Field
Light > Canvas
Audio > Panel
Viden » Seroll View
ul » Event System
Carnera SEIREE
Materals

Gambar 5.62: Menambahkan Button

Kemudian ubahlah Scale Button menjadi 2 agar tombol tidak
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terlalu kecil.

= Higrarey #HScene ® Inspector
o [3uton | [ Static
Tag | Untagged #| Layer [uI ¢

v € arrumah*

Cirectonal Licht
P ARCamera
P ImzgeTargst

¥5C RectTransform ]
center Pos X Fos ¥ Pos Z

[370.8 264 I[c |
Wicth Height

x[ts Ivlos ]
I

Rotation

Scae Yz ]
Canvas RendeFer .
¥ v "5 ¥ Image (Script) Ay
cobr —
Wateris T —
Raycast Target "4
Imege Type |Slized i
B Project Fill Center "}
| create -| ¥ o ¥ Button (Script) ]

I Assets »

Gambar 5.63: Ubah Scale Button

Lalu ubah “Rect Transform” menjadi disebelah kanan atas agar
tombol tepat berada disebelah pojok kanan atas.

= Hierarchy @ Inspector
«| @At ) :
| cém | (EeAT | & G T=y—
¥ € arrumah* =
o o . T Unt, d # | L U1
Directional Light ag [Untagge | Layer [
F ARCamera 733 Rect Transform
P ImageTarget ok & oo =

¥ Canvas -130.7 I[-38 o
@ Width Height
Text 119.7 30
EventSystem Anch resets
Shift: AlsOyget pivot  Alt: Also set position

Z
|
F
center right stretch = D
E_

Gl

ElEE
TS B
LmE BE—

"ECEIEE,

Gambar 5.64: Ubah Rect Transform

I~

bottam middI

stretc

Lihat pada Hierarchy kemudian pilih Button > Text, lalu ubah
text pada tab Inspector menjadi “Keluar”
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= Hiearchy # Scene @ Inspecter
.|l @A ) - 3 i
Create | @Al ) Saaded 20 || & | <) | a o [Text -
v & arrumah* = i T S J
Directional Light e — LD -
» ARCamera v55 Rect Transform |
» ImageTargzt stratch Left Tor PosZ
v Conver - Com— ——
i Right Bottom
» Ancars
Keluar Pivet x5 vfos ]
Rotation xo  vlo Tz ]
Scae XL yn oz
@ canvas Renderer o,
v | M Text (Script) %,
o
Keluar
Character
Fant o
3 Project g Fant Style
| create -] Fatt Size -

Gambar 5.65: Mengedit Teks

Setelah itu klik pada Canvas dan ubahlah Canvas Scaler pada
tab Inspector menjadi seperti pada gambar dibawah ini.

‘= Hierarchy © Inspector

| create | (arAll ) a [« Canvas | ] Static = |«
‘f@arrumah* == Tag [Untaqqed t] Layer [UI &
Directional Light =y
b ARCamera ¥+ Rect Transform
[Same wvalues are driven by anather object.
% S
512 300 4]
Text Width Height
EventSystem 1024 500
b Anchaors
Fivot X|0.5 ¥ 0.5
Rotation H 0 Y0 Z 0
Scale H1 Y1 Z|11
YE‘EEanva!
Render Mode | Screen Space - Overlay
Pixel Perfect |
Sort Order 0

Target Display [ Display 1
Additional Shader CH Mathing

"Etan\ra! Scaler (Script)
UI Scale Mode | Scale With Screen Size

Reference Re olutiol)( Y |-—_|

Screen Match Mode | Match Width Or Height
Match

. =)
Width Height

Reference Pixels Per 100

Gambar 5.66: Canvas Scaler

Selanjutnya tambahkan GameObject pada tab Hierarchy, pilih
Create > Create Empty.
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3D Object H
2D Object b
Effects H
Light »
Audio H
Video »

Gambar 5.67: Menambahkan GameObject

Setelah menambahkan GameObject, kemudian ganti nama men-
jadi “objekkeluar” yang nantinya akan berfungsi sebagai script ke-
luar dari aplikasi. Klik kanan pada GameObject > Rename menjadi
“objekkeluar”.
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H5cene ]
Shaded

= Hierarchy
| Create *l (oAl
v Qarrumah* =
Directional Light
b ARCamera
P ImageTarget
¥ Canvas
¥ Button
Text
EventSystem
GameObject

Copy
Paste

Rename
Duplicate
Delete

Gambar 5.68: Mengganti Nama GameObject

‘= Hierarchy

| Create "’| (oAl
Tﬂarrumah* =
Directional Light
b ARCamera
b ImageTarget
¥ Canvas
¥ Button
Text
EventSystem
objeklkeluar

Gambar 5.69: GameObject

5.2.4 Membuat Tombol Keluar

Setelah mengubah nama GameObject, kemudian tambahkan se-
buah script. Lihatlah pada tab Inspector kemudian pilih Add Com-
ponent lalu ketikkan scriptkeluar dan tekan Enter.
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= Hierarchy @ Inspector
I I e Y i
- [ |objekkeluar | [ static v

Tag [ Untagged  ¢| Layer [Default %]

"Q arrumah*

objekkeluar

Gambar 5.70: Menambahkan Script

Biarkan kolom Name tetap menjadi scriptkeluar, lalu klik pada
Create and Add.

= Hierarchy
(emua | (Al |
- ¥ |objekkeluar | [] static =

Tag | Untagged  #| layer |Default %]

v ) arrumah*

objekkeluar

Gambar 5.71: Script Keluar

Setelah berhasil menambahkan script kemudian klik dua kali/
double click pada scriptkeluar.
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& Inspector | =

[+ objeklkeluar [ ] static =

Tag | Untagged s | Layer | Default s |

¥ .~ Transform £,

Position M B5B.791 |¥ 195.6986 £ T3B.4478
Rotation ®|0 |0 Z0
Scale ®1 |1 Z[1

‘f@ [+ Mothing SElectec [a) %,
Seript | - scriptkeluar | @

Add Component

Gambar 5.72: Klik Dua Kali pada “scriptkeluar”

Maka akan muncul script/coding, kemudian tambahkan coding-
an menjadi seperti dibawah ini, kemudian tekan Ctrl+S untuk me-
nyimpan coding.

using System. Collections;
using System. Collections. Generic;
using UnityEngine;
public class scriptkeluar : MonoBehaviour {
public void keluaraplikasi () {
Application. Quit () ;
}
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- scriptkeluar.cs x _

Gscriptkeluar # |1 keluaraplikasi ()

1 using System.Collections;

2 using System.Collections.Generic;

3 using UnityEngine;

4

5 public class scriptkeluar : MonoBehaviour {
6

7 public void keluaraplikasi () {
B Application.Quit () ;
s}

1@ }

11

Gambar 5.73: Script Keluar

Tahap selanjutnya yaitu menambahkan fungsi pada tombol ke-
luar. Klik pada Button di tab Hierarchy yang terletak pada Canvas,
kemudian pada tab Inspector, klik tanda + pada On Click().

‘i= Hierarchy @ Inspector
|create -| @Al ) |

"Qirrumih‘

Button

on Click ()
List is Empty

L]
Default UL Material —
> Shader | Ul/Default |

S0 amponen

Gambar 5.74: Menambahkan OnClick
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Kemudian tarik objectkeluar pada tab Hierarchy ke dalam On-
click(), lihatlah pada gambar dibawah ini.

= Hierarchy
|Create-| @Al ) || (ColorTint ] 4

v €} arrumah* = ®sButton (Image

[

| wisualize |

wobjekkelu: o

Gambar 5.75: Tarik GameODbject

Setelah GameObject berhasil ditarik ke dalam On Click(), selan-
jutnya klik pada “No Function” dan ubah fungsinya menjadi “kelu-
araplikasi()”, maka sekarang tombolnya dapat berfungsi jika di klik.
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@ Inspector
Transition | Calor Tint 4];
Target Graphic  ®sButton (Image) | @
Mormal Color | | 22
Highlighted Color | | #
Pressed Color | |2
Disabled Color | v
< Persp Color Multiplier
Fade Duration 0.1 |
Mavigation | Automatic i)
I Visualize I
on Click ()
R o + | Mo Fun n
Wobjekkeluz ©f [ N Function
GameObject ¥ v o=
Default UI Transform > 2l #.
bool enabled scriptkeluar » .
string name
. Mdd Component ]
bool runinEditMode
v
string tag

bool useGUILayout
BroadcastMessage (string)
Cancellnvoke (string)

e e L

T ﬂh’n Slec 0

keluaraplikasi ()

1 i
aon =

SendMessageUpwards (string)
StopAllCoroutines ()

StopCoroutine (string)

Gambar 5.76: Mengatur Fungsi OnClick
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5.2.5 Build Aplikasi

Langkah selanjutnya yaitu build aplikasi, klik menu File > Build
Setting.

=4 Unity 2017.2.0f3 Personal (64bit) - arrum

File Edit Assets GameObject Compo

Mew Scene Ctrl+M
Open Scene Ctrl+0
Save Scenes Ctrl+5
Save Scene as... Ctrl+5Shift+5
MNew Project...

Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build & Run Ctrl+B
Exit

Gambar 5.77: Build Setting

Klik pada Add Open Scenes kemudian klik Player Setting, dan
lihat pada tab Inspector > Resolution and Presentation.
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Build Settings x

Scenes In Build

I arrumah 5
P—
Platform
A .
@, PC, Mac & Linux Standalone a Android

Testure Compression
Build System Internal (Default) 3

a i0s Export Project

Development Build
® 1y tvos Autoconnect Profiler
Script Debugging

g Tizen Scripts Only Build

E Xbox Cne Compression Method

SDKs for App Stores

o

PS5 Wita
711 iaomi Mi Game Center Add

=ra P54

— b Learn about Unity Cloud Build

[ |
|_Switch Platforrll | Player Settings... | I [ Build ||__Build And Run_|

Gambar 5.78: Player Setting

Kemudian Ubah Default Orientation menjadi Lanscaped Left,
agar nanti saat menjalankan aplikasi menjadi terlihat Landscape
dan rotasinya tidak dapat berputar-putar dan tetap padarotasi Lan-
scape kiri.
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O Inspector
- -
Default Cursor
Cursor Hotspot )(|0
3 | #
Settings for Android
Resolution and Presentation
Resolution Scaling
Resolution Scaling Mode | Disabled &l
Blit Type | Always =
Supported Aspect Ratio
Aspect Ratio Mode | Super Wide Sereen (2.1) =
Orientation
Default Orientation® [ Landscape Left :
Use 32-bit Display Buffe Portrait
Disable Depth and Stenc Portrait Upside Down
Show Loading Indicator Landscape Right
* Shared setting between m . Landscape Left
| TEEn Auto Rotation

Gambar 5.79: Mengatur Orientation

Setelah itu tekan Build untuk membangun projek yang telah di-
buat menjadi sebuah aplikasi yang akan berjalan pada smartphone
Android.
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Build Settings x

Scenes In Build

I arrumah [1}

Add Open Scenes

Platform

é" PC, Mac & Linux Standalone
(=

a Android

Texture Compression | Don't override i)
Build System | Internal (Default) ™

E i0s Export Project (|
Development Build L]

&y tvos Autoconnect Profiler O
Script Debugging |

g Tizen Scripts Only Build O

—~

"‘ Xbox One Compression Method | Mone 1]

SDKs for App Stores
PS \ita

ml Kiaomi Mi Game Center Add

—ra P54

— nity Cloud Build
[ Switch Platform I[ Player Settings... ] Build And Run

Gambar 5.80: Build Aplikasi

Kemudian simpan aplikasi dengan nama AR Rumabh lalu tekan
Save dan tunggu hingga proses build aplikasi selesai.

<t Build Android

U » ThisPC » Documents » AR Rumah v Search AR Rumah L
Organize v MNew folder == - o
comet " Name Date modified Type
@ OneDrive Assets File folder
& Documents Library File folder
& Lampiran Email obj File folder
X ProjectSettings File folder
& Music y
QCAR File folder
al Pictures Temp File folder
I3 This PC UnityPackageManager File folder
- 3D Objects
[ Desktop
@ Documents wllz >
File name: "
Save as type: | apk ~
4 Hide Folders Cancel

Gambar 5.81: Lokasi Penyimpanan Aplikasi
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Jika muncul peringatan Android SDK is outdate, Anda bisa meng-
abaikan nya dengan pilih “Use Highest Installed” atau memilih “Upda-
te Android SDK” untuk menambahkan versi SDK Android terbaru
dan memerlukan koneksi internet. Tetapi jika ada error saat bui-
lding berarti SDK Anda perlu di Update.

Android 5DK is outdated
Cancel

I

Detecting current SOK Buid Tools version... | SDK Build Tools version 23.0.1 < 25.0.0.
Expolt Project = |
Development Build

Autoconnect Profilsr
Update Android SDK Cancel Use Highest Installed

oooch

Script Debugging
Scripts Only Build

Compression Method .
SDKs for App Stores
ml Hiaomi Mi Game Center ‘
b’ Learn about Unity Cloud Build
Player Settings... Build || Build And Run_|

Gambar 5.82: Peringatan Update SDK

Setelah proses building selesai, maka aplikasi Anda berhasil di-
buat dan salinlah .apk tersebut ke smartphone Android Anda un-
tuk dijalankan.

Jangan lupa simpan projek pada Unity dengan menekan tom-
bol Ctrl+S.
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Home  Share  View
=]
u b cut

s Copy path

T New item =

1] Easy access -

« B X =}

@ % Open ~
Edit

ick Copy Paste _ Move Copy Delete Rename  New Properties
[2] Paste shorteut 4o+ - older - & History
Clipboard Organize New Open
A > ThisPC > Local Disk(C) » Users > Comet-ID > Documents > ARRumah
Documents A" Neme Date modified
=] Pictures #* Assets
comet ~ Library
& OneDrive obj
ProjectSettings
& Documents
QcAR
& Lempiran Email Temp
&) Music wekogeiviomyger
& Pictures AR Rumah
[ ThisPC P N
. | /AR Rumah,userprefs
B8 3D Objects T Assembly-Csharp.csproj
[ Desktop [] Assembly-CSharp-Editor.csproj
Documents
¥ Downloads
D Music
&=| Pictures

' Redmi Note 4
w Kartu SD

— Penyimpanan interma

B videos

%, Local Disk (C)

12 items

+ Copy to root of storage

v

1item selected 22.0 MB

Gambar 5.83: Menyalin Apk

[ setectan
| select none
£ invert selection
Select

Type Size

File folder
File folder
File folder
File folder
File folder
File folder
File folder
APK File 22,529 KB
SLN File 2KB
USERPREFS File 1KB
CSPROJ File 11KB
CSPROJ File 12K8

Kemudian buka File Manager pada Smartphone Anda, lalu in-
stal aplikasi “AR Rumah.apk” yang telah Anda salin dan jalankan.

= Penyimpanan.. Q 3
&} > akar > sdcard ata]
AR Rumah.apk
20/12/17 23.37 22,00 MB

_Radio_Asik_...203622.apk
20/12/17 1119 23,07 MB

Vi!‘
'
N4 V]

° _Ebbok_tes_6203501.apk
20/12/17 1011 7,80 MB

y‘ Aplikasi_Ebo...n_Bisnis.apk
ARLA 1op1217 2222 27,84 MB

_Ebook_Islam...197719.apk
9 19/12/17 09.56 1717 MB

[AII+ROMs]...Booster].zc

15/12/17 19.29 178 KB
Gambar 5.84: File Manager

_Ebook_Islam...198016.apk
19/12/17 11.31 1716 MB
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() L
Q AR Rumah
Apakah Anda ingin memasang aplikas
ini? Aplikasi tidak memerlukan akses
khusus apa pun.

BATAL PASANG

Gambar 5.85: Install Aplikasi

Jalankan aplikasi “AR Rumah” yang telah di instal pada smar-
tphone Android Anda. Bila ada popup seperti gambar dibawah ini
maka tekan Izinkan, biasanya muncul pada Android versi 6.0 kea-
tas.

G Izinkan AR Rumah
untuk mengambil
gambar dan merekam

video?

TOLAK IZINKAN

Gambar 5.86: Perizinan Aplikasi

Setelah itu arahkan kamera ke gambar/marker yang telah An-
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da buat dan arahkan posisi yang tepat agar gambar/marker mu-
dah terbaca. Setelah pas maka akan muncul objek 3D Rumah dan
tombol keluar yang akan berfungsi keluar dari aplikasi jika tombol
tersebut ditekan.

Gambar 5.87: AR Rumah dan Tombol Keluar
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Membuat Augmented Reality

Allosaurus Bergerak

Pada Bab ini akan dijelaskan cara membuat aplikasi Augmented
Reality Allosaurus yang dapat bergerak yaitu model 3D dinosaurus
dengan animasi. Anda perlu menyiapkan 1 buah gambar yang ak-
an dijadikan marker

Objek 3D yang digunakan pada pembahasan kali ini di unduh
pada website Asset Store Unity yang berisi Asset yang telah dibuat
oleh para developer yang bisa kita gunakan secara gratis dan ada
juga yang berbayar.
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6.1 Membuat Projek Baru Unity

Langkah pertama yaitu membuka Unity dan membuat projek ba-
ru, pilih New, lalu berilah nama projek tersebut dengan nama “AR
Allosaurus”, kemudian klik Create project.

AR Allosaurus

C:\Users\Comet{D\Documents

@®3D (2D | AddAsse Package

Gambar 6.1: Membuat Projek Baru

Setelah jendela Unity terbuka, selanjutnya klik Build Setting atau
tekan Ctrl+Shift+B. Pilihlah platform Android kemudian klik Swi-
tch Platform.
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¥ Unity 2017.2.03 Personal (B4bit) - Untitl

File Edit Assets GameObject Compe

Mew Scene Ctrl+M
Open Scene Ctrl+0
Save Scenes Ctrl+5
Save Scene as... Ctrl+5Shift+5
Mew Project...

Cpen Project...
Save Project

Build Settings... Ctrl+5hift+B
Build & Run Ctri+B

Exit

Gambar 6.2: Build Setting

Build Settings x

Scenes In Build

Platform
i Android
é}, PC, Mac 8 Linux Standa\on@ a
Texture Compression | Don't averride =
Build System | Internal (Default) o
E i0s Export Project O
Development Build -
&0y tvos Autoconnect Profiler O
Script Debugging O
ﬁ Tizen Scripts Only Build ]
E Xbox One Compression Method [ Mane
SDKs for App Stores
PS Vita
ml Wiaomi Mi Game Center | Add |
—ra P54
— Learn about Unity Cloud Build
| |
|[ Switch Platform ]IPIa\far Settings... [ Build ][ Build And Run
————

Gambar 6.3: Platform Android

Selanjutnya yaitu mengimport Vuforia Package ke dalam Unity.
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Klik menu Assets > Import Package > Custom Package.

Assets | GameObject Component  Window  Help

| Create

i Show in Explorer
Open
Delete

Open Scene Additive

Import Mew Asset...
Import Package

Export Package...

Find References In Scene

Select Dependencies

Refresh
Reimport

>

Ctrl+R

cene € Game &

20 || @t | <) |

ed =

Custom Package...

2D

Carmeras
Characters
CrossPlatformlnput

Effects

Gambar 6.4: Menambahkan Custom Package

Carilah lokasi Vuforia Package yang tadi telah Anda unduh bia-

sanya terletak pada folder Downloads, klik Open, kemudian tekan
Import.

< Import package ...

&« v » ThisPC » Data(D:) » ARRumah »
Organize = Mew folder
3 This PC
) 3D Objects ‘1‘

[ Desktop L x‘

|j Documents
BACKUP Buku
# Downloads AR Hadi

Js Music

= Pictures

I RedmiNote 4
m Videos

i Local Disk (C:)
- Data (D)

¥ Network b

U

New folder

v @ | Search AR Rumsh P

vuferia-unity-6-
2-10

File name: | vuforia-unity-6-2-10

v| unitypackage ~

Gambar 6.5: Vuforia Package
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Import Unity Package x

vuforia-unity-6-2-10
4 Iicense_Srdpar‘t\rnotice.t][t CED &
M [ link xml EED
¥ o S5 rlugins
¥ [ 55 android
™[] androidManifest.xml (e
v o CSlibs
¥ o &5 armeabi-v7a
I [ libVuforia.so bl
[+ | |libVufariaUnityPlayer.so U
[ [ |libVufariaWrapper.so i
¥ s
¥ o 55 com
¥ I 5 vuforia
¥ o S5 vuforiaunityPlayer
[ | |Debuglog.java i
¥ [ orientationUtility java  GE3
]

Gambar 6.6: Import Package Vuforia

Jika muncul peringatan “Api Update Required”, maka tekan “I
Made a Backup, Go Ahead”.

APl Update Required 3

This project contains scripts andfor assemblies that use
obsolete APIs,

If you choose 'Go Ahead', Unity will automatically
uparade any scriptsassemblies in the Assets folder
found using the old APIs. You should make a badkup
before proceeding.

(ou can always run the API Updater manually via the
'Assets/Run API Updater' menu command.)

| I Made a Backup. Go Ahead! | Mo Thanks

Gambar 6.7: API Update Required

Setelah itu drag/menarik ARCamera dan ImageTarget ke dalam
tab Hierarchy. Pada Tab Project di Unity, buka folder Assets > Vufo-
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ria > Prefabs, lalu pilih ARCamera dan ImageTarget kemudian tarik

dalam tab Hierarchy.

= Hierarchy ® .= | i Scene € Game £ Asset Store 8 Animator
| Create - | (@Al ) ||| shaded BRI Gizmos ~
v €{ untitled* -=
Main Camera
Directional Light
ARCamera

@ Project [, Console

N

T
4 Assets » Vuforia - Prefabs

i ARCamera

| Create 7|
¥ 1 7Favorites
@AH Materials
(1 Al Models
@A\\ Prefabs

ind 4rg
¥ G Assets f ImageTarget
» &5 Plugins T
(& Resources i ObjectTarget
¥ &5 vuforia I TextRecognition
» & Editor i UserDefinedTargetBuilder
& Fonts I VirtualButton
[ Materials I VuMark
i Word
& Resources
= - b

Gambar 6.8: Drag ARCamera dan ImageTarget

Kemudian klik pada ImageTarget di tab Hierarchy, kemudian
klik “No Target defined” pada tab Inspector.

“= Hierarchy & .= | © Inspector o -=

| Create -! Q'A*H ) ¥ ImageTarget [] Static v =
¥ QMUET:'::':;HE = Tag (Untagasd +| Layer [ Default 3
Directional Light Prefab | Sslect I Ravare I APElY J
P ARCamera ¥ .~ Transform #,
Position x[o ¥[o zlo
Rotation Xo Y o Z0
Scale X1 Tl Z1
¥ |\ ¥Mesh Renderer (L #
» Lighting
» Materials
Dynamic Occluded W
7é ¥ Image Target Behaviour (Script) #*,
Script 5ImageTargetBehaviour (2]
Ty Do 4]
J

[ I Mo targets defined. Fress here for target creation! I

v|e  Turn Off Behaviour (Script) E &

Script TurnOffBehaviour [0}
¥ || (Mesh Filter) 3,
Mesh [ !
V ¥/ Default Trackable Event Handler (Script) *,
Script DefaultTrackableEventHandler Lol

--- EMPTY ---Material

Gambar 6.9: Klik pada No Target
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6.2 Membuat Marker

Langkah selanjutnya membuat marker dan mendownload Vuforia
Package, pertama buka halaman website Vuforia lalu login dengan
akun yang telah Anda buat sebelumnya.

s vuforia™ beveloper Portal

Home Pricing Downloads Library Develop Support

License Manager  Target Manager

Target Manager

Use the Target Manager to create and manage databases and targets.

(U
Log In to janage targets

Gambar 6.10: Website Vuforia

Masukkan email dan password akun Vuforia Anda.

Email Address

sttework@gmail.com

Mot Registered? Create account now

Password
sssssses

Forgot password?

Gambar 6.11: Halaman Login Vuforia

Setelah login, klik tombol “Get Development Key” untuk mem-
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buat License baru.

s vuforia™ beveloper Portal

Home Pricing Downloads Library Develop

License Manager Target Manager

License Manager

Create a license key for your application.

Get Development Key Buy Deployment Key

Gambar 6.12: License Manager

Berilah nama License Key dengan nama “AR Allosaurus” dan
beri ceklis pada cexbox kemudian klik Confirm.

License Manager Target Manager

Back To License Manager

Add a free Development License Key

App Name

‘ AR Allosaurus ‘ You can change this later

License Key

Develop

Price: No Charge

Reco Usage: 1,000 per month
Cloud Targets: 1,000
VuMark Templates: 1active
VuMarks: 100

¥l By checking this box, | acknowledge that this license key is subject to the terms
and conditions of the Vuforia Developer Agreement.

Cancel Confirm

Gambar 6.13: Menambahkan Kode Lisensi

Setelah berhasil maka akan ada sebuah License Key, lalu klik
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pada License Key yang telah Anda buat.

License Manager Target Manager

License Manager

Create a license key for your application.

Get Development Key Buy Deployment Key

Name Type

AR Allosaurus Develop

Gambar 6.14: Berhasil Menambahkan Kode Lisensi

Kemudian simpan atau salinlah License Key tersebut yang nan-
tinya akan digunakan pada Unity.

AR A"OSGUI’US Edit Name Delete License Key

License Key Usage

Please copy the license key below into your app

AW6uSEH/////ARRAMVtExZNoi kHYimZZjpRE2FEHEvb6358kEZLu
zA710fUWwvj+SKPKBIKJDLIQZLNnYEnv4SjKfJwiRZa2/YvB0pavo

SP/OhWN3WxwwT8hbkhTNqvv19]j6Y0LoY+IYs/ 3mT 4muWfhHIUMB
BLvU+1xy4iCWYLdvrVyRgzSu3J14KyXFuEarPlwyj 8DA0ONUYzBx

PE1gvggxwJ6LmBIVEuXS3p3pglbTjbm7p2NaHZmaéM/O0tGylei/5
OABAdPhVkVVzADDICxygcoglarS6YDCTsd0pMP 7/ UNOwANl JMy 1
heHnrXP1IMhOscPigaaK3JFGecPjvaGHY4cYEqQItJ+LAr+pohEPr

11+z1GMflneNHzZZ

Type: Develop
Status: Active
Created: Dec 21, 2017 06:30

Gambar 6.15: Kode Lisensi

Kemudian masuk ke menu Target Manager, buatlah sebuah da-
tabase terlebih dahulu. Klik tombol Add Database kemudian beri
nama sesuai keinginan Anda lalu klik Create.
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$ vuforia- Developer Portal

Home Pricing Downloads Library Develop

License Manager Target Manager

Target Manager

Use the Target Manager to create and manage databases and targe

Add Database

Gambar 6.16: Target Manajer

Create Database

Name:

| MarkerAllosaurus

Type:

® Device
) Cloud
) VuMark

Cancel Create

Gambar 6.17: Membuat Database

Setelah berhasil, maka akan muncul database yang telah Anda
buat. Kemudian klik database tersebut.
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Target Manager

Use the Target Manager to create and manage databases and targets.

Add Database

Database Type Targets
damayanti Device 1
Dilah Device 1
dinda Device o}
intan Device 1

MarkerAllosaurus Device 2

MarkerAllosaurus
markerm

Device 3

Gambar 6.18: Berhasil Membuat Database

Klik Add Target untuk membuat sebuah marker baru.

License Manager Target Manager

Target Manager » Markerallosaurus

MarkerAllosaurus e iame
Type: Device

Targets (0)

Add Target

Target Name Type

Gambar 6.19: Menambahkan Target

Kemudian klik Browse untuk memilih gambar yang akan digu-
nakan sebagai marker. Setelah memilih gambar, kemudian klik
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Open.

Add Target
Type:
(A 9 00 §
Il
<)
Single Image Cuboid Cylinder 3D Object
File:
Choose File Browse..
Jpg or .png (max file 2mb) Tidak ada fil

Gambar 6.20: Mencari Lokasi Gambar

Gambar 6.21: Gambar Untuk dijadikan Marker
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9 Open
< v A » OneDrive » Pictures » Screenshots v & Search Screenshots y-]
Organize v New folder =~ T @
~ ~
& OneDrive '
% Documents [ [ ——

Lampiran Email

o
&l Music @ 2017-12-21
& Pictures

3 This PC

_J 3D Objects

[ Desktop

@ Documents

* Downloads

J! Music

=] Pictures v allosaurus-dinosaur-draw v

File name: | allosaurus-dinosaur-draw V| Sermua Jenis File ~

I Open |v| Cancel

Gambar 6.22: Memilih Gambar untuk Marker

Lalu isilah Width dengan ukuran sesuai keinginan Anda, dan
beri nama marker tersebut lalu klik Add.

(A9 OU @

Single Image Cuboid Cylinder 3D Object

File:
Browse...

Jpg or .png {max file Zmb)

Width:

1000

of your target in scene units. The size of the target should be on the
same scale as your augmented virtual content. Vuforia uses meters as the default unit
scale. The target's height will be calculated when you upload your image.

allosaurus

Name must be unigue to a database. When a target is detected in your application, this
will be reported in the API

Cancel Add

Gambar 6.23: Mengatur Ukuran Marker

Perlu diperhatikan juga rating bintang yang didapatkan dari mar-
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ker, semakin kecil rating bintang maka semakin sulit databasenya
untuk dibaca oleh kamera. Kemudian beri cekbox lalu Download

Database.

Target Marager > Marke-Allosaurus

MarkerAllosaurus e yen
Type: Cevice

Targzts (1)

Adc Target Downlcad Detabase (1)

Target Namsz Tvce Rating Status v Date Modified

Tselected  Delete

|.1 E allosaurus Single ‘mage Active Dec 27,2017 06:35

Gambar 6.24: Mengunduh Database Marker

Lalu akan muncul pop-up, pilihlah Unity Editor kemudian tek-

an Download.

Download Database

1 of 1active targets will be downloaded
Name:

MarkerAllosaurus

Select a development platform:

Android Studio, Xcode or Visual Studio
e Unity Editor

Cancel Download

Gambar 6.25: Memilih Platform

Setelah berhasil mengundubh, file akan berupa unitypackage, se-
lanjutnya Import ke Unity pilih Assets > Import Package > Custom

Package.
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Assets | GameObject Component  Vuforia  Window  Help
Create *
Show in Explorer
Open MIEIEEAE T
Delete

Open 5cene Additive

Import New Asset...

Import Package » Customn Package...
Export Package... 20
Find References In Scene

Cameras
Select Dependencies Characters
Refresh Ctrl+R CrossPlatforminput
Reimport Effects

Reimport All Environment

ParticleSystemns
Extract From Prefab Prototyping

Run APl Updater... Utility

Gambar 6.26: Menu Import Package

Kemudian carilokasi unitypackage yang tadi telah Anda unduh.
Pilih package tersebut kemudian klik Open lalu Import.

&« v ‘ » ThisPC » Downloads » v D Search Downloads -l i

Organize v New folder E ~ T o
* Downloads & ™ . JA\‘ ~
Documents —

[&] Pictures » APLIKASI JADI Compressed Documents Mr. Robot
Season 2
comet bs [ourfriends22.blo
gspot.co.id]

i OneDrive

& Documents
o a
% Lampiran Email 0 A
& Music a8
@ Pictures i Programs Video w

& This PC
4§ 3D Objects
[ Desktop
Documents
<L Downloads 04 v

File name: | MarkerAllosaurus V| —nitmackane -

Gambar 6.27: Memilih Package Marker
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Import Unity Package x

MarkerAllosaurus

¥ & S Editor
¥ I G vuforia
v g.‘__lmageTargetTextures
¥ [ 5 Markerallosaurus
[ il allosaurus_scaled.jpg [y
v @.‘_‘Streamingnssets
¥ M &5 vuforia
[ [markerallosaurus.dat [y
[ [ |Markerallosaurus.xml —_

All None Cancell Import I

Gambar 6.28: Mengimport Package

Setelah berhasil mengimport, Klik ImageTarget pada tab Hie-
rarchy terlebih dahulu, lalu Anda akan melihat Database pada tab
Inspector, gantilah Database tersebut dengan Marker Database yang
telah Anda Import.

“Etrarcny | @9 6 spector | a-=|
"Céa:R ‘Alli::urus* — i ImageTarget [ Static * /&
Main Camera Tag | Untagged 3| Layer | Default i
Directional Light Prefab | Select | Revert | Apply |
_’ YA : _Transfurm g
Position Xo Yo Z0
Rotation X0 Yo Z0
Scale X 1000 Y 1000 Z 1000
¥ . [¥Mesh Renderer @
¥ Lighting
» Materials
Dynamic Occluded 4
YE@Imaqe Target Behaviour (Script) @l
Script riImageTargetBehaviour @
Type | Predefined ™
Database | MarkerAllos aurus t]
Image Target [ allosaurus ol
W TO00
Height 637.5839

Preserve child size -
Enable Extended Trach |
Enable Smart Terrain [ |

allosaurusMaterial

Gambar 6.29: Database Marker

Jika setelah Database marker dipilih masih blank berwarna pu-
tih maka marker harus untuk mengatasinya di reset terlebih dahu-
lu. Buka folder Assets > Editor > Vuforia > ImageTargetTextures >
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markerar.

E3 Project

llEtl = Ed

allosaurus_scaled

== Markerallosaurus

& allosaurus scaled.ip

Gambar 6.30: Tekstur Marker

Kemudian klik reset pada icon pengaturan di tab Inspector, ma-
ka marker akan menampilkan tekstur Database-nya.

@ Inspector

Gambar 6.31: Reset Tekstur Marker
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(O B S | ot | 13 [ ecenter [ @ local [UNTRRY <
= Hierarchy & o= | #Scene € Game 9 Asset Store P8 Animator |
| create - | @rAT - 2 | )| w3

fl
il

v €0 AR Allosaurus*
Main Camera
Directional Light

» ARCamera

ImageTarget

1 Project El console o=
| reate - a [EIENES
¥/ Favorites 4 Assets » Editor » Vuforia » ImageTargetTextures » MarkerAllosaur:

©) All Materials B allosaurus_scaled
©1 Al Models
©, All Prefabs

¥ & Assets
¥ &5 Editor
¥ & Vuforia
¥ G ImageTargetTextures
== MarkerAllosaurus

¥ & Plugins
(& Resources
I 5 StreamingAssets
¥ & Vuforia
» OS5 s dis
/\ OnLevelWasLoaded was found on VuforiaAbstractBehaviour

Gambar 6.32: Gambar Marker

Selanjutnya klik pada ARCamera di tab Hierarchy, lalu buka pe-
ngaturan Vuforia. Pada tab Inspector klik “Open Vuforia configu-

ration”.
= Hierarchy = == | © Inspector &L=
| cé“‘ z| AT ¥ [ARCamera [_] Static
¥ € AR Allosaurus* =
u d 3 Defaul 3
Main Camera Tag [Untaggs JICayer oafals J
Bl (Lish Prefab | Select | Revert 1 Apply ]
ARCamera ¥ .~ Transform o,
ImageTarget Position x[-561 Yo z-2424
Rotation X0 Yo Z0
Scale X|1 Y1 Z[1
() ¥ Audio Listener &+,
Ys |+ Vuforia Behaviour (Script) -5
Script &VuforiaBehaviour @
World Ce a S o
| &
I I Open Vuforia cenfiguration I ]
Y @De#au i inlila |zailnn Error ﬁana er iE(rlp!) &,
Script DefaultInitializationErrarHandler [c]
[ Add Component ]

Gambar 6.33: Pengaturan Vuforia

Kemudian paste/sisipkan License Key yang telah Anda buat ta-
di di website Vuforia. Jangan lupa ceklis pada kedua kolom Data-
sets agar database nanti dapat terbaca.
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. wuforiaConfiguration

Gambar 6.34: Menyalin Kode Lisensi
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6.3 Asset Store

Asset Store adalah perpustakaan atau kumpulan asset yang bisa di-
gunakan yang disediakan oleh pada developer, ada versi gratis dan
juga berbayar.

Tahap selanjutnya buka Asset Store atau tekan Ctrl+9, untuk
mencari asset Allosaurus yang akan digunakan sebagai model 3D
pada aplikasi AR Allosaurus ini.

File Edit Assets GameObject Component Vuforia  Window Help

il + Next Wincow Ctri+Tab
m‘ a .= ’E Previous Window Ctrl+5hift+Tab
| Create ~ arAll Sha: s 5
"QAR Allesaurus™ =

Main Camera Services Ctrl+0
> ig;:t::::al Light Scere Ctrl+1
ImageTarget Garre Ctrl+2
Inspzctor Ctrl+3

Hierarchy Ctrl+4

Project Ctrl+5

Animation Ctrl+6

Profler Ctrl+7

Audo Mixer Ctrl+3

Asset Stors Ctrl+3

Gambar 6.35: Menu Asset Store

Setelah itu ketikan Allosaurus pada kolom pencarian Asset.

uforia Window Help

S )

| Htscene € Game 1 Asset Store

L]

EN v Create Account  Logln

allosaurus| % Filters ¥ ﬂ

Welcome to the Asset Store

[0

€] nust h

2017 Year

In Review 2 | L= 5
@ Project O consele - =
| Create - 0 [EIED]
¥ i/ Favorites 4| Assets » Resources

CL All Materials < yuforiaConfiguration

©L Al Models

(L All Prefabs

Gambar 6.36: Asset Store
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Kemudian pilihlah Allosaurus yang bertuliskan FREE, lalu klik

Download.

fuforia  Window Help

_ocal
# Scene € Game i Asset Store

4
[}

EN + | Create Account | Logln

s

LowPoly Dinosaur AD1
3D Characters/...

v
i Project [l Console =
| Create - Q ‘.P_I\|,\
Vﬁfavorites 4| Assets » Resources
Il Materials ] VuforiaConfiguration

LAl Prefabs

¥ il Assets
¥ & Editor
¥ &5 Vuforia
vﬁ ImageTargetTextures
&l Markerallosaurus

Gambar 6.37: Memilih Asset

Jufona  Window  Help

ey > T o)
. # Scens € Game £ Asszt Store

4 ® = EN + | Create Account | Logl

*okkk (1182)
FREE

Download

\ (9) (1) () (5)

The package includes an Allosaurus model wth eight differen animations and three 2043x2048 resolution diffuse
textures.

i1 Project Econscle -
Create = 0, CARNE]

Gambar 6.38: Mengunduh Asset

Apabila diminta Sign In, maka masukkan terlebih dahulu Email
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dan Password akun Unity yang telah Anda buat.

< Unity 2017.2.013

&Q unity

Sign into your Unity ID

If you don't have a Unity ID, please create one

Email

cometwork@gmail.com Sign in with google
Password Or
n Sign in with facebook

Forgot your password?

Can't find your confirmatior ail?

Gambar 6.39: Login Akun Unity

Setelah berhasil Download Allosaurus, selanjutnya klik Import.

Import Unity Package x

Allosaurus
¥ o 5 Allosaurus -
v ¥ £5 allosaurusSources [MEW]
v I+ 55 anims ez
I+ Allosaurus_Attackol.anim
I % allosaurus_Attacknz.anim [
I ¥ allosaurus_Die.anim
I % Allosaurus_Hito1.anim [
I ¥ Allosaurus_Hitoz.anim
| ¥ allosaurus_Idle.anim [
|t '{‘E‘Allnsaurus_IdIeAggressivc.anim e
| I(.’E";ﬂhllvz:ae:aurl.Je:_I|::IIv::En.':II-::m'ml.ar‘lir‘r‘l [MEW]
) I(:E."MII»::saurus_]ur'r'l[.‘:l..anir'r'l ez
[ IE\'ﬂ.llm:aur’l.ui_]ur'r'l|::|Lei‘t.ar'|ir'r'|
I % allosaurus_JumpRight.anim HEL [P
& . p—

Gambar 6.40: Mengimport Asset
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Jika ada peringatan seperti gambar dibawah ini, maka klik “I
Made a Backup, Go Ahead!”.

APl Update Required

This project contains scripts and/or assemblies that use
obsolete APIs.

If you choose 'Go Ahead', Unity will automatically
upgrade any scripts/assemblies in the Assets folder
found using the old APIs. You should make & backup
before proceeding.

(fou can always run the API Updater manually via the
‘Assets/Run API Updater' menu command.)

| I Made a Backup. Go Ahead! | Mo Thanks

Gambar 6.41: Peringatan Api Update Required

Kemudian drag atau tarik model 3D “Allosaurus_01” dalam fo-
lder Assets > Allosaurus > AllosaurusSources > Prefab ke ImageTar-
get.Bila model 3D terlalu besar, Anda dapat merubahnya dengan
mengatur skala pada tab Inspector, lalu letakan model 3D pas dia-
tas marker.

File Edit Asects GameObject Component Vuforia Window Help

B + B
E ierarch

Il

€ Game

20 || % | <) | &d - | Gizmas ~| (@Al

aaaaa

@ Project O Console
| Creste <]
¥ Favorites
(1 Al Materials
(1 All Models
(L All Prefabs

sa
» &5 Standard Assets
» & Editor

» &5 Plugi
& Plugins =

Gambar 6.42: Tarik Model ke Image Target
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File Edit Assets GameObject Component Vufoia Window Help

¥ (&5 Standard Assets
» &5 Editor
» G Plugins

Gambar 6.43: Mengatur Skala Model

Kemudian uji coba aplikasi dengan menekan tombol Play pada
Unity. Arahkan marker ke kamera maka apabila berhasil akan tam-
pil 3D Allosaurus. Jangan lupa simpan projek Anda dengan menek-
an Ctrl+S.

File Edit Assets GameObject Component Vuforia Window Help

Gambar 6.44: Uji Coba Aplikasi
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6.4 Build Aplikasi

Langkah selanjutnya yaitu build aplikasi, klik menu File > Build
Setting atau bisa juga menekan tombol Ctrl+Shift+B.

-
File Edit Assets GameQbject Comp

Mew Scene Ctrl+M
Open Scene Ctrl+O
Save Scenes Ctrl+5
Save Scene as... Ctrl+Shift+5
Mew Project...

Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build & Run Ctrl+B
Exit

Gambar 6.45: Menu Build Setting

Pilih platform Android, kemudian klik pada Player Setting un-
tuk mengatur icon aplikasi dan nama aplikasi. Ubah “Company
Name” dengan nama Anda, kemudian ubah “Product Name” de-
ngan nama AR Allosaurus.
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Build Settings

& PC, Mac & Linux Standalone F
B o

&0/ tvos
ﬁ Tizen
E Xbox One

PS Vita

ml Hiaomi Mi Game Center m
—ra PS4
I

‘lllllii
| i
o

Select Texture2D b3l © Inspector

Settings for Android

Resolution and Presentation
Resolution Scaling
anusauru Care Resolution Scaling Mode | Disabled
o <l | Blit Type [ Always
256 = C 4
Supported Aspect Ratio
Aspect Ratio Mode [ SuperWide Screen (2.1) ¢

:Targe:-tTe:-][l-:l;r::"s,-"l\lark erAllo?

Gambar 6.47: Mengatur Nama Aplikasi

Setelah itu ubah “Package Name” pada “Other Settings” menja-
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di “com.(nama anda).allosaurus” (tanpa spasi).

contoh: com.hadi.arallosaurus

8 Inspcctoar e

Resolution and Presentation

8

Icon
Splash Image

Other Settings

Rendering
Color Space* | Gamma
Auto Graphics API d
Graphice APIs
— QpenGLES2
+,
Multithreaded Rendering® o
Static Batching
Dynamic Batching 7]
GPU Skinning™* =

Graphics Jobs (Experimer| |
Virtual Reality mowved to ¥R Sethings
Protect Graphics Memery [

Identification
Fackage Mame com.hadi.allesaurus
Varsion® : |

Gambar 6.48: Mengatur Package Name

Lalu ubah Orientation menjadi Landscape agar layar pada hp
nanti nya tidak rotasi otomatis dan tetap pada tampilan Landsca-
pe. Klik Resolution and Presentation > ubah Orientation menjadi
Landscape Left sesuai.
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8 Inspector

Default Cursor

Cursor Hotspot )(|0 |Y|0

i s | ¥
Settings for Android

Resolution and Presentation

Resolution Scaling

Resolution Scaling Mode | Disabled
Elit Type [ Always

Supported Aspect Ratio
Aspect Ratio Mode | Super Wide Screen (2.1)

Orientation

Default Orientation® [Landscape Left
Use 32-hit Display Buffer? Portrait
Disable Depth and Stencil Portrait Upside Down

Show Loading Indicator Landscape Right

* Shared setting between mul. Landscape Left

Auto Rotation

| Icon

Gambar 6.49: Mengatur Rotasi Layar

Setelah mengganti Orientation, yang perlu Anda lakukan yaitu
klik tombol Build yang terdapat pada menu Build Setting, kemudi-
an beri nama aplikasi tersebut, lalu klik Save.
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Build Settings

& PC, Mac & Linux Standalone F
id
B o

&1y tvos

ﬁ Tizen

"‘ Xbox One

‘llllli‘
o

PS Vita

ml Xiaomi Mi Game Center
=ra P54

T~ B <« Documents » AR Allosaurus » v O Search AR Allosaurus »p
~
Mame Date modified Type
|] Assets 12/21/2017 €47 AM  File folder
|] etc 12/21/2017 &:45 AM  File folder
& OneDiive || Library 12/21/2017 6:49 AM  File folder
a b e |] ProjectSettings 12/21/2017 6:45 AM  File folder
acminen . I] QCAR 12/21/2017 52 AM  File folder
| Lampiran Email [] Temp 12/21/2017 6:55 AM  File folder
& Music | UnityPackageManager 12/21/2017 1:07 AM  File folder
EI‘I Pictures
[ This PC
P 3D Objects
[ Desktop
>
File AR Allosaurus o
Save as - S—— ~
~ Hide Folders | Save | Cancel

Gambar 6.51: Menyimpan Lokasi File
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Jika muncul peringatan Android SDK is outdate, Anda bisa meng-

abaikan nya dengan pilih “Use Highhest Installed” atau memilih
“Update Android SDK” untuk menambahkan versi SDK Android
terbaru dan memerlukan koneksi internet. Tetapi jika ada error sa-
at building berarti SDK Anda perlu di Update.

Scenes In Build

Add Open Scenes

Platform
é" PC, Mac & | e
, Android 5DK is outdated
5 . Cancel
& Android Detecting current SDK Build Tools version... SDK Build Tools version 23.0.1 < 25.0.0,
ﬁ i0s Export Project . |
Development Build L]
&y tvos Autoconnect Profiler
Script Debugging Update Android SDK Cancel Use Highest Installed
Tizen Scripts Only Build
@ Xbox Ona e b r -
iurus » Prefabs
SDKs for App Stores -
PS Vita Loz
Add I
ml Hiaomi Mi Game Center To3
=ra P54 _03_controller
— b/ Learn about Unity Cloud Build
| Switch Platform || Player Settings.. | L Build [ Build And Run_|

Gambar 6.52: Peringatan SDK is outdate

Setelah proses building selesai, maka aplikasi Anda berhasil di-
buat dan salinlah .apk tersebut ke smartphone Android Anda un-
tuk dijalankan. Jangan lupa simpan projek pada Unity dengan me-

nekan tombol Ctrl+S.
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& cut 5 B x \EII I3 New item - @ ©yopen~  Hgselectan

ma Copy path 7] Easy aceess ~ Edit Select none
LTSS [#] Paste shortcut '\:S".E Sy e feere ,Z‘ﬁ,“:, RS £ History g7 Invert selection
Clipboard Organize New Open Select
4 | > ThisPC » Local Disk(C:) > Users > Comet-ID > Documents > AR Allosaurus
[Z) Documents # ™ Name . Date modified Type
=] Pictures * Assets 12421 File folder
comet * ete 1 File falder
& OneDrive Library 1 File folder
ProjectSettings 12/ File folder
@l Documents Qcar 1 File folder
@i Lempiran Email Temp 12 File folder
&/ Music pindackzoshanaos 1 File folder
al picures E
~ [ This PC
8 3D Objects
[ Desktop
[ Documents
4 Downloads
D Music
&=] Pictures

v I Redmi Note 4
= Kartu'SD
= Penyimpanan internal

B Videos

> “ia Local Disk (C:)

=+ Caepy to root of storage

Gambar 6.53: Menyalin Aplikasi ke Smartphone

Kemudian buka File Manager pada Smartphone Anda, lalu in-
stal aplikasi “AR Allosaurus” yang telah Anda salin tersebut.

© Q8 S e

= Penyimpanan.. Q &

&} > akar > sdcard g8

g AR Allosaurus.apk
21/12/17 07.04 20,82 MB

AR Rumah.apk
20/12/17 23.37 22,00 MB

_Radio_Asik_...203622.apk
2011217 N9 23,07 MB

° _Ebbok_tes_6203501.apk

20/12/17 1011 7,80 MB
A — -

71 Aplikasi_Ebo...n_Bisnis.apk

R4 19217 2222 27,84 M8

Il _Ebook_Islam...198016.apk
- 19/12/17 11.31 17,16 MB

£ _Ebook_Islam...197719.
=2 19/12/17 09.56 1717 MB

Gambar 6.54: File Manajer
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AR Allosaurus

Apakah Anda ingin memasang aplikasi
ini? Aplikasi tidak memerlukan akses
khusus apa pun.

BATAL PASANG

Gambar 6.55: Memasang Aplikasi

Jalankan aplikasi “AR Allosaurus” yang telah di instal pada smar-
tphone Android Anda .Bila ada popup seperti gambar dibawah ini
maka tekan Izinkan, biasanya muncul pada Android versi 6.0 kea-
tas.

Izinkan AR Allosaurus
untuk mengambil

gambar dan merekam
video?

TOLAK IZINKAN

Gambar 6.56: Perizinan Aplikasi

Setelah itu arahkan kamera ke marker/imagetarget yang telah
Anda buat sebelumnya dan arahkan posisi yang tepat agar marke-

160



Membuat Augmented Reality Allosaurus Bergerak

r/imagetarget mudah terbaca. Apabila berhasil maka akan muncul
model 3D Allosaurus.

Gambar 6.57: Aplikasi Berhasil di Jalankan
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Menambahkan Objek,
ImageTarget, dan Suara

Pada Bab ini akan dijelaskan cara untuk menambahkan Objek, Ima-
geTarget, dan Suara dalam 1 buah Aplikasi.

Tentu saja aplikasi Augmented Reality Anda akan lebih menarik
apabila ada suara dan objek 3D bergerak. Sebelumnya Anda per-
lu menyiapkan gambar untuk marker baru dan sebuah file audio

berformat .wav, .mp3, atau .ogg.
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7.1 Menambahkan Objek

Pada tahap ini akan dijelaskan cara menambahkan 2 objek 3D ke
dalam 1 marker. Buka folder Assets > Allosaurus > Allosaurus Sour-
ces > Prefab > kemudian tarik file “Allosaurus_02" ke dalam Image-

Target.

= Hierarchy EEE Fscene € Game.
| create -| @rAT ) ||| shaded || 20 || # | <)
v €) AR Allosaurus* =

Directional Light
» ARCam:
¥ ImageTarget

P Allosauru

Allos.

[EIEYES

+| Assets » Allosaurus » Prefabs

* Allosaurus_02

P i Allosaurus_03_Controller

uuuuu

Gambar 7.1: Menambahkan Objek 3D

Kemudian aturlah Skala objek 3D tersebut, dan letakkan pas di-

atas marker.

= Hlerarz.:h.y i PR ® Inspector [ ﬁﬁg‘_

|iGreate x| (EeAT 2 w [ [Allosaurus_02 [ static =
v € AR Allosaurus* = :
TR Tag | Untagged | Layer | Defaul
Directional Light Prefab | Select Revert Apply
F ARCamera ¥ .~ Transform had
¥ Egcle el Position x[0.199 [0 2/0.004
. DN O O
R Scale x[0.1 Y01 z oD
¥ > ¥ Animatiof I7ES |
Animation |l Allosaurus_Walk e

¥ Animations
Play Automatically I

Animate Physics -
Culling Type | Always Animate ™
Add Component J

Gambar 7.2: Mengatur Skala
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Selanjutnya yaitu menguji coba aplikasi. Klik tombol play pada
Unity, kemudian arahkan gambar yang telah dibuat sebagai mar-
ker pada bab sebelumnya, maka akan muncul 2 objek 3D Allosau-
rus.

us - Android <DX11 on DX9 GPU>

Gambar 7.3: Uji Coba Aplikasi
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7.2 Menambahkan ImageTarget

Pada tahap ini akan dijelaskan cara menambahkan ImageTarget.

Bukalah Database MarkerAllosaurus yang sebelumnya telah An-
da buat, kemudian tambahkan target baru klik pada Add Target.

License Manager Target Manager

Target Manager > MarkerAllosaurus

MarkerAllosaurus e name
Type: Device

Targets (1)

Add Target

Target Name Type

1selected Delete

7 E allosaurus Single Image

Gambar 7.4;: Menambahkan Marker

Kemudian carilah lokasi gambar lain untuk membuat marker
baru.
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Add Target
Type:
Single Image Cuboid Cylinder 3D Object
File:
Choose File Browse...

Jpg or .png (max file 2Zmb)

Tidak ada1

Width:

Enter the width of your target in scene units. The size of the target should be on the
same scale as your augmented virtual content. Vuforia uses meters as the default unit
scale. The target's height will be calculated when you upload your image.

Gambar 7.5: Mencari Lokasi Gambar untuk Marker

Gambar 7.6: Gambar untuk dijadikan Marker

Setelah memilih gambar baru yang akan dijadikan marker ke-
mudian klik Open.
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9 Open

&« ~ 4 [l » Search Results in Pictures v O al
Organize v = ~ M
3 Quick access

[ Desktop +
l- Downloads

éﬁ"

= Allosaurus W allesaurus_by ka allosaurus- your_soul_by_ar
|5 Documents ek-dSinsbd dinosaur-draw m_ali-d7djhvp
| Pictures ¢

comet +

Search again in:
i OneDrive 1 Libraries gTh\s pC B Custom...
& Documents
& Lampiran Email
& Music v
File name: | allosaurus_by_kaek-d9insbd V| Semualeniz File

Open v| Cancel

Gambar 7.7: Lokasi Gambar

Lalu aturlah ukuran marker dan beri nama allosaurus2 untuk
membedakan dengan marker yang sebelumnya telah Anda buat.

File:
Browse..
Jpg or.png (max file 2mb)
Width:
1000
Enter the width of your target in scene units. The size of the targat should be on the

same scale as your augmented virtual content. Vuforia uses meters as the default unit
scale. The target's height will be calculated when you upload your image.

Name:

| allosaurusz

Name must be unigue to a database. When a target is detected in your application, this
will be reported in the API.

Cancel Add

Gambar 7.8: Mengatur Ukuran dan Nama Marker

Setelah berhasil menambahkan marker, maka akan tampil 2 Da-
tabase marker. Beril ceklis pada kedua Database tersebut, lalu klik

Download Database.
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License Manager  Target Manager
MarkerAllosaurus

Target Manager >

MarkerAllosaurus .-
Type: Device

Targets (2)

Add Target

@ Target Name Type

Single Image

Single Image

Date Modified

Status v

Active Dec 21, 2017 07:26

Active Dec 21, 2017 06:35

Gambar 7.9: Memberi Ceklis pada Kedua Database

Setelah itu pilihlah platform Unity Editor, dan tekanlah tombol

Download.

Download Database

2 of 2 active targets will be downloaded

Name:
MarkerAllosaurus

Select a development platform:

Android Studio, Xcode or Visual Studio

® Unity Editor

Cancel

Download

Gambar 7.10: Database Platform Unity Editor

Tunggulah beberapa saat, sampai proses unduh selesai.

Lalu bukalah Unity Editor, kemudian pilihlah menu Asset > Im-

port Package > Custom Package
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Assets  GameObject Component  Vuforia  Window  Help
Create ¥ |
Show in Explorer
Open
Delete

Open Scene Additive

Import New Asset...
Import Package > Customn Package...
Export Package... a0
Find References In Scene
Cameras
Select Dependencies CRaracters
Refresh Ctrl+R CrossPlatforminput
Reimport Effects
Reimport Al Environment
ParticleSystems

Gambar 7.11: Menu Import Package

Kemudian carilah lokasi Database marker terbaru yang telah
Anda unduh yang berisi 2 Database, kemudian klik Open dan tekan
Import.

< Import package ...

4 & » ThisPC » Downloads » v @ | Search Downloads P
Organize v Mew folder = - | o
+ Downloads & * Q'L\‘.Q - 4
(5] Documents # APLIKASIJADI Compressed Documents Mr. Robot
| Pictures * Season 2
[ourfriends22.blo
comet ol gspot.co.id]
& OneDrive
& Documents @ E\
& Lampiran Email OL‘
& Music =
] Pictures TTeTe Programs w
This PC
- 3D Objects
[ Desktop
=] Decuments MarkerAllosaurus arkerllosaurus
‘ Downloads 6 m b
File name: | MarkerAllosaurus (1) V| RETT:TyaioF: o T S it

Gambar 7.12: Mengimport Package Database Marker Baru
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Import Unity Package %

MarkerAllosaurus (1)

¥ of 5 Editor
¥ o o5 vufaria
¥ @i;;.lmageTargetTextures
b4 @;;;Markernllosaurus
Elilallosaurusz_scaled.jpg i

ET3|losaurus_scaled.)pg & =]
v @-ﬁ-streaminghssets
v @;ﬁ:u‘uforia
I | Markerallosaurus.dat AR =
| MarkerAllosaurus.xml et =]
All Nane Import

Gambar 7.13: Mengimport Package Marker

Setelah berhasil mengimport Database marker, kemudian bu-
kalah folder Assets > Editor > Vuforia > ImageTargetTextures > Mar-
kerAllosaurus kemudian klik pada kedua file tersebut dan tekan
Reset pada logo gerigi yang ada pada tab Inspector.

—————————
spring
Convoluton Type (mene ]

Fixup Edge Seams [

SRGB [Color Texture)

| Bcensle

[ [% % b advance
extures » MarkerAllosaurd

Waterials
©1 All Models
(L All Prefabs

[Revert | Apaly |

Gambar 7.14: Reset Tekstur Marker
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Setelah menekan Reset maka gambar dari marker akan terlihat.
Kemudian tambahkan ImageTarget ke Hierarchy, bukalah folder
Vuforia > Prefabs > kemudian pilih ImageTarget dan tarik ke tab

Hierarchy.

= Hierarchy |

oD #Scene

| create »| (@rAll

v Q AR Allosaurus*

Main Camera
Directional Light
® ARCamera
F ImageTarget

ImageTarast (1)

-[l20 || % |4 & ] e

B,

All Models

[& Resources
» [ StreamingAssets
¥ Vuforia

| Assets » Vuforia » Prefabs
& SmartTerrain
b i ARCamera

' All Prefabs I CloudRecognition
¥ G Assets " ® ImageTarget
» &l Allosaurus [ ]
b (i Editor iy ObjectTarget
¥ Gl Plugins I TextRecognition

i UserDefinedTargetBuilder
It VirtualButton

L VuMark
» &5 Editor i word
(& Fants

(& Materials

= prefabs

Gambar 7.15: Menambahkan ImageTarget

Kemudian lihatlah pada tab Inspector, lalu pilihlah Database
MarkerAllosaurus kemudian ubahlah Image Target menjadi allo-
saurus2.
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@ Inspector
¥ ImageTarget (1) ) | static =
Tag | Untagged t| Layer | Default |
Prefab | Select | Revert | Apply |
¥ .~ Transform %,
Position X -42 Yo 20
Rotation Xo Yo 20
Scale X 1000 Y 1000 Z 1000
¥ ;- ¥ Mesh Renderer
b Lighting
b Materials

Dynamic Occluded &

Vaglmige Target Behaviour (Script)

Script raImageTargstBehaviour

Type | Pradefined

Database | Markerallasaurus

Image Target allosaurus2 4+ |
Width u I 2 [ |
Height |

allosaurus

Preserve child size
Enable Extended Trach |
Enable Smart Terrain [

—

Gambar 7.16: Memilih ImageTarget ke 2

Setelah merubah Database, maka gambar marker akan tampil
pada jendela Unity. Selanjutnya tarik file “Allosaurus_03” ke dalam
ImageTarget yang kedua.

= Hierarchy

Directional Light
» ARCamera

ateri
' all Models
©LAll Prefabs

v il Assets.
v 5 Allosaurus

Gambar 7.17: Menambahkan Objek 3D ke ImageTarget ke 2

Setelah itu ubahlah skala objek 3D, dan letakkan pas diatas Ima-
geTarget.
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= Hierarchy l & == | ® Inspector L e
| Create | (G0 Al ] | |Allosaurus_03 [L] static =
¥ €{ AR Allosaurus* =
e Tag | Untagged 4| Layer | Default |
Directional Light Prefab | Select | Revert | Apply |
» ARCamera ¥ .~ Transform ﬁ-ﬂ
¥ ImageTarget Position X -0.022 (YO 2/-0.085
A Rotation %o I¥o E0
G xoiz vz ]
v [+ Animation Wl i-
Animation [I}Al[qsaprus_w‘alk | @
I Animations
Play Automatically [
Animate Physics LJ
Culling Type | Always Animate m

Add Component

Gambar 7.18: Mengatur ukuran Objek 3D

Jika Anda ingin mengubah animasi dari Walk menjadi Run, bu-
kalah folder Assets > AllosaurusSources > Anims > kemudian tari-
klah Allosaurus_Run ke dalam Animation Allosaurus_Walk, maka

Animation akan berubah menjadi Allosaurus_Run.

Fscene € Game. £ Asset Store. 1 © Inspector )
[ shaded {20 || % | 9) | & -] e o () Static v
- ) Layer (Defaule 3
wert | Apply ]
TEY
Yo zro0is
z0
zoaz
T=

Add Component

:::::

Gambar 7.19: Merubah Animasi

Setelah berhasil mengganti animasi, selanjutnya bukalah pe-
ngaturan Vuforia, klik pada ARCamera kemudian lihatlah pada tab

Inspector lalu klik Open Vuforia configuration.
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= Hierarchy & .= | © Inspector | e
reate | (oAl
LGRS A | ARCamera [] static =
v QAR Allosaurus* - =
— — — Tag [ Untagged +| Layer | Default &)
Prefab | Select | Revert | Apply |
¥ .~ Transform 3 =,
o - f (1) Position X 1080 Y -153 Z|-2077
mageTarge i T i BT
» Allasaurus_03 Rotation Xfﬂ V:D ‘20
Scale ®i1 ¥l [Z|1
(©) ¥ Audio Listener [
v @ ¥ vuforia Behaviour (Script) G #
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Gambar 7.20: Membuka Pengaturan Vuforia

Setelah membuka pengaturan Vuforia, Anda akan melihat “Max
Simultaneos Track” gantilah angka 1 menjadi 2.

® Inspector | e

E VuforiaConfiguration & ==
(Open | |
¥ Vuforia
App License Key AWBUSEH///// ARAAMYExZNoikHYImZ 2]

pKEZfEHEvbE358kEZLuz AT1OfUWwWY]+5
|KPKBIKIDLIaZLnYEnv4SiKflniRZaz/Yvs |
Delayed Initialization [ ]

Camera Device M "BEFALLT m
Max Simultansous racl[§ |
Max Simultaneous : ]

Load Object Targets on [
Camera Direction | cAMERA_DEFAULT =i}
Mirror Video Backgroun| DEFAULT 4]

¥ Digital Eyewear

Eyewear Type | Mone =
¥ Datasets
Load Markerallosaurus
Activate

Gambar 7.21;: Max Simultaneos Track

Kemudian Anda bisa mencoba menjalankan Aplikasi dengan
klik tombol Play pada Unity. Arahkan gambar ke 2 yang telah An-
da buat menjadi marker, maka akan muncul objek 3D Allosaurus
dengan animasi berlari. Jadi Anda memiliki 2 marker yang bisa di-
gunakan dalam 1 aplikasi.
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Gambar 7.22: Menguji Coba Projek Aplikasi
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7.3 Menambahkan Suara

Setelah berhasil menambahkan Objek dan ImageTarget, Anda juga
bisa menambahkan suara pada aplikasi.

Bukalah projek AR Allosaurus, kemudian klik Create pada tab
Hierarchy lalu pilih Audio > Audio Source.

File Edit Assets GameObject Component WVuforia Window

’@ - = | oo | ]E” :-.[..-ICenter| & Local ]

_Hlerarch m = FScene
.ﬁ.II || Shaded
reate r‘npt_',r E =

Create Empty Child

30 Object *

20 Object ¥

Effects *

Light »

Audio * Audio Source

Video » Audic Reverb Zone

Ui ¥
Camera

Gambar 7.23: Menambahkan Audio

Setelah itu tambahkan suara berformat mp3/Audio, klik kanan
pada folder Assets lalu pilihlah Import New Asset. Kemudian cari-
lah lokasi file mp3/Audio yang akan Anda Import lalu tekan Open.
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Gambar 7.24: Mengimport Asset Baru

<4 Import New Asset

“ . 5> ThisPC » Data (D:) > AR Rumah v B | Search AR Rumah o

Organize » Mew folder oo in | o

£ =
& Lampiran Email

o Ve T
2| Pictures [} x‘ &3 @

[ This PC
== BACKUP Buku New folder Tyrannosaurus

- 3D Objects AR Hadi Rex

[ Desktop

lﬂ Documents
* Downloads
J! Music

&= Pictures

ﬂ Videos

. Local Disk (C:)
- Data (D2)

¥ Network M

File name: | Tyrannosaurus Rex v| All files ~

Gambar 7.25: Mengimport File Audio

Setelah mp3/Audio berhasil Anda Import, kemudian tarik file
mp3/Audio tersebut ke dalam AudioClip pada tab Inspector. Beri
ceklis pada box “Play On Awake” dan “Loop”, agar audio tersebut
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berjalan saat aplikasi dijalankan dan mengulang otomatis ketika
audio berhenti.

+] Layer [Defaule )
nsform [FE]
x[505 [-43 15808 | 2[4 170044
X0 Yo zlo

X[z Y[t 2l

olume.
ot O censale
i

DUAEEERLE |

Add Component

Gambar 7.26: Memasukkan File Audio ke AudioClip

Setelah itu tambahkanlah script agar file audio tersebut dapat
berfungsi. Lihatlah pada kolom search/ kolom pencarian, kemu-
dian ketiklah defaulttrack maka Anda akan melihat file “Default-
TrackableEvenHandler” lalu klik 2 kali pada file tersebut.

25 Projec_t El Console

! Create *|

All Models
20 all Prefabs

> %ﬁssets

Gambar 7.27: Mencari Script

Tunggu beberapa saat maka akan tampil jendela Mono Deve-
lop, kemudian tepat diatas teks #region UNITY MONOBEHAVIOUR_METHODS
tambahkanlah teks public AudioSource suara;
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1 > DefaultTrackableEventHandler.c: ©

7 using UnityEngine;

9 namespace Vuforia

ie {

12 that e e I e tHandl ace
4 public class DefaultTrackableEventHandler : MoncBehaviour,

5 ITrackableEventHandler

6 {

7 #region PRIVATE MEMBER WARIABLES

18

a9 private TrackableBehaviour mTrackableBehaviour;

i ARIABLES

22

23 public AudioSource suara;

#region UNTIY_MOMOBEHAVIOUR METHODS

Gambar 7.28: Menambahkan Script

Kemudian lihatlah ke baris bawah dan cari OnTrackingFound(); te-
pat dibawah teks tersebut tambahkan tulisan suara.Play(); dan juga
tambahkan teks suara.Stop(); tepat dibawah OnTrackingLost();

Setelah itu tekan save dengan menekan Ctrl+S.

LeFventRandber Fanetion

d bnTrackableStateChanged(

47 TrackableBehaviour.5tatus previousStatus,
43 TrackableBehaviour.5tatus newStatus)
49 {
5@ if (newStatus == TrackableBehaviour.Status.DETECTED ||
51 newStatus == TrackableBehaviour.Status.TRACKED ||
52 newStatus == TrackableBehaviour.Status.EXTENDED TRACKED)
53 {
= o g ;
56 }
57 else
58 1
e 2
I suara.Stop ()3 |
¥
¥
#endregion // PUBLIC METHODS

Gambar 7.29: Menambahkan Script 2

Setelah menambahkan fungsi script, selanjutnya lihatlah pada
tab Hierarchy kemudian klik ImageTarget yang pertama lalu tarik
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file “Audio Source” yang ada pada tab Hierarchy ke dalam kolom
“Suara” yang ada pada tab Inspector.

Gambar 7.30: Tarik Audio Source ke Suara

Anda juga bisa menambahkan suara ke ImageTarget yang ke-
dua, klik pada ImageTarget yang kedua lalu tarik file “Audio Sour-
ce” yang ada pada tab Hierarchy ke dalam kolom “Suara” yang ada
pada tab Inspector.

Gambar 7.31: Tarik Audio Source ke Suara ImageTarget ke 2
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Lalu uji coba aplikasi dengan menekan tombol Play pada Unity,
dan arahkan gambar yang telah Anda buat sebagai marker. Ma-
ka model 3D Allosaurus akan tampil sesuai dengan Database yang
ada pada gambar marker tersebut dan juga ada suara audio yang
akan jalan otomatis ketika objek 3D muncul.

iforia Window Help

Gambar 7.33: Menguji Coba Aplikasi 2

Jangan lupa simpan projek Anda dengan memilih menu File >
Save Scenes atau tekan Ctrl+S.
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=t Unity 2017.2.0f3 Personal (64bit) - AR Allg
File Edit Assets GameObject Compc

Mew Scene Ctrl+M
Cpen Scene Ctrl+0)

Mew Project...
Open Project...
Save Project

Build Settings... Ctrl+5Shift+B
Build & Run Ctrl+B
Exit

Gambar 7.34: Menyimpan Scene
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7.4 Membuat Tombol Keluar

Setelah projek Anda berhasil dijalankan, selanjutnya tinggal me-
nambahkan tombol untuk keluar dari aplikasi.

Bukalah kembali projek “AR Allosaurus” Anda, kemudian klik
kanan pada ruang kosong di tab Hierarchy, pilih UI > Canvas.

= Hierarchy :--;' . | #H+Scene
| Creit_e__'i (e All i Shaded

h J QAR Allosaurus =
~ Main Camera
Directional Light
* ARCamera
#ImageTarget
» ImageTarget (1)
Audio Source

Copy
Paste
Rename Text
Duplicate image
Deloia Raw Image
Button
Select Prefab T
oggle
Create Empty Slider
30 Object ¥ Scrollbar
2D Object » Dropdown T
Effects » bl shal ate |
Light » Canvas Favorites |
: s (1 all Materials |
Aud » Panel =3
S i (O All Models
Video ¥ Screll View @\{,AII Prefabs
ul » Event System
Camera |'

Gambar 7.35: Membuat Canvas

Kemudian tambahkan Button, klik kanan pada Canvas lalu pilih
UI > Canvas.
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= Hierarchy [

| Create '| oAl N

Y@AR Allosaurus*
Main Camera
Directional Light

b ARCamera

b ImageTarget

» ImageTarget (1)
Audio Source

Shaded.

Copy
Paste
Rename et
Duplicate g
Delete ) 2

Button
Select Prefab

Toggle
Create Empty Slider
3D Object > Scrollbar
2D Object > Dropdown
Effects > Input Field
Light ¥ Canvas pusites X

Il Materials

Audio > Panel Il Models
Video » Seroll View Il Prefabs
= . S ets |
Camera I I

Gambar 7.36: Menambahkan Tombol

Setelah menambahkan Button, kemudian aturlah skala atau ukur-
an Button pada tab Inspector menjadi 1,5 atau sesuai keinginan
Anda.

185



Menambahkan Objek, ImageTarget, dan Suara
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Gambar 7.37: Mengatur Ukuran Tombol

Selanjutnya klik pada kotak pada “Rect Transform” kemudian

pilih kotak pojok kanan atas, agar posisi Button tepat berada di po-
jok kanan atas dan menyesuaikan dengan ukuran layar.
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Gambar 7.38: Mengatur Rect Transform

Lalu ganti teks pada Button menjadi teks “Keluar”, klik pada
Button terlebih dahulu lalu pilih tanda panah kecil yang berada pa-
da Button, maka akan terlihat “Text”. Selanjutnya klik “Text” terse-
but lalu ubah Text “Button” yang ada pada tab Inspector menjadi
teks “Keluar”

187



Menambahkan Objek, ImageTarget, dan Suara
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Gambar 7.39: Mengedit Teks pada Button

Setelah berhasil mengganti teks pada Button, selanjutnya tam-
bahkan script yang akan berfungsi ketika tombol Button ditekan.
Klik Create > lalu pilih Create Empty.

i= Hierarchy =l
T PE—_
| creata =| (CrAll y

Create Empty

Create Empty Child

3D Object »
20 Object ¥
Effects *
Light »
Audio 3
Video *
il *

Camera

Gambar 7.40: Menambahkan GameObject

Maka akan bertambah file bernama “GameObject” kemudian
tambahkan script pada file tersebut. Lihatlah pada tab Inspector
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kemudian klik Add Component, lalu ketiklah dan beri nama script-
keluar lalu tekan Create and Add.

Gambar 7.41: Menambahkan Script

Setelah berhasil menambahkan script, selanjutnya klik 2 kali
pada script tersebut. Tunggulah beberapa saat maka akan tampil
jendela Mono Develop.
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& Inspector | =
I 4 & GameObject [l Static =
Tag | Untagged 4| Layer | Default 4|
¥ .~ Transform =
Position X[535.3632 |Y[224.8178 |Z[224.896
Raotation ® 0 Y0 Z|0
Scale ¥l | [Z]1 _
v || ¥ Scriptkeluar 149) @ =
Script scriptkeluar (c]

fdd Component

Gambar 7.42: Script Berhasil ditambahkan

Setelah tampil script tersebut, kemudian editlah script tersebut
menjadi seperti dibawah ini, kemudian tekan save dengan menek-
an Ctrl+S pada keyboard.

using System. Collections;

using System. Collections. Generic;

using UnityEngine;

public class scriptkeluar : MonoBehaviour {

public void keluaraplikasi () {
Application. Quit () ;
}
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k DefaultTrackableEventHandler,c: scriptkeluar.cs
s selection
1 using System.Collections;
2 using System.Collections.Generic;
3 using UnityEngine;

public class scriptkeluar : MonoBehaviour {

public woid keluaraplikasi () {
8 Application.Quit () ;

Gambar 7.43: Script Keluar

Setelah menyimpan script tersebut, bukalah kembali jendela
Unity dan klik Button pada Hierarchy. Kemudian lihatlah pada tab
Inspector, Anda akan melihat OnClick() kemudian klik pada tanda
plus (+) tersebut.

= Hierarchy N :m] 0 e
lereawe | GrAl 0 ||| Material [None (Material) | o
T@AR Allosaurus* = Raycast Target
~ Main Camera Image Type | Sliced ]
Directional Light Fill Center ]
» ARCamera
» ImageTarget ¥ o [ Button (Script) 2,
» ImageTarget (1) Interactable 4
Audio Source Transition | Colar Tint =
Target Graphic !_‘iE_!L,It_tt_:!'] {Image) R:]
Normal Color | 12
Highlighted Color 2|
EventS\rs.tem Pressed Color i
Sl Disabled Color &
Color Multiplier — (r——— 1 _|
Fade Duration 0.1 |
Navigation | Autamatic &
| Wisualize |
On Click (_]!
List is Emipty
[ + F |
Default UI Material ME

Gambar 7.44: Menambahkan Fungsi Tombol

Setelah tanda plus (+) di klik, selanjutnya tarik “GameObject”
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ke dalam kolom missing “OnClick()”.

Gambar 7.45: Menarik GameObject

Kemudian ubah “No Function” agar tombol Keluar dapat ber-
fungsi ketika di klik. Pilihlah scriptkeluar > keluaraplikasi().
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Gambar 7.46: Mengatur Fungsi Tombol

Setelah menambahkan script dan mengatur fungsi tombol An-
da dapat mencoba menjalankan pada Unity dengan menekan tom-
bol Play. Kemudian tombol Keluar akan tampil pada Unity, tetapi
tombol Keluar tersebut tidak dapat di klik karena dalam mode Ga-
me Unity, dan hanya dapat berfungsi ketika ditekan pada Smar-
tphone Android. Lalu tekan Stop dengan menekan tombol Play la-
gi, maka akan kembali ke mode projek.
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Gambar 7.47: Menguji Coba Aplikasi
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7.5 Build Aplikasi

Langkah selanjutnya yaitu build aplikasi, klik menu File > Build
Setting atau bisa juga menekan tombol Ctrl+Shift+B.

File Edit Assets GameObject Compe

Mew Scene Ctrl+M
Open Scene Ctrl+O
Save Scenes Ctrl+5
Save Scene as.. Ctrl+Shift+5

Mew Project...
Open Project...

Save Project

Build Settings... Ctrl+5Shift+B
Build & Run Ctrl+B
Exit

Gambar 7.48: Menu Build Setting

Pilih platform Android, kemudian klik pada Player Setting un-
tuk mengatur icon aplikasi dan nama aplikasi.
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Build Settings x

Scenes In Build
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{ Build System Intarnal (Default) m
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Development Build -
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Script Debugging L]
€a Tizen Seripts Only Build ]
@ Xbos One | compression Method
SDKs for App Stores
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m' Hiaomi Mi Game Center Add
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— ik Learn about Unity Cloud Build
| ]
| Switch P\atfm'ml“ Player Settings... J E_M Build And Run
e |

Gambar 7.49: Player Settings

Ubah “Company Name” dengan nama Anda, kemudian ubah
“Product Name” dengan nama AR Allosaurus.

BInspectr | -
" % PlayerSettings

Company Name |hadi
Product Name [AR Allosaurus

Select Texture2D

Default Icon

allosaurus...

Cloud
Reco

CloudReco...

- |
| a Settings for Android
| Resolution and Presentation

Resolution Scaling

Default Cursor

Cursor Hotspat

Resolution Scaling Mode | Disabled |
Bt Type

Supported Aspect Ratio

Aspect Ratio Mode | Super Wide Screen (2.1) #]/| &

Gambar 7.50: Mengatur Icon dan Nama Aplikasi
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Kemudian tekan Build untuk membuat aplikasi, lalu beri nama
aplikasi tersebut dan tekan Save.

uild Settings %

Scenes In Build

Add Open Scenes
Platform
é, PC, Mac & Linux Standalone H Andraid
i

e o ekt
Build System Internal (Default) +
Export Project -
S evalapmEn: Build m
Autoconnect Profiler Ll
Seript Debugaing "
Scripts Only Build -

p‘\ Xbox One Compression Method
SDKs for App Stores

PS Vita

71| xiaomi Mi Game center Add

=ra P54

-
-

Unity Cloud Build

]
| Switch Platformfl|[ Player Settings... | I [ Build_ 1| Build And Run

Gambar 7.51: Build Aplikasi

<4 Build Android

T <« Documents » AR Allosaurus » v | & Search AR Allosaurus o
Organize ~ New folder Bz (7]
~
@ Music A Name Date modified Type
& Pictures Assets 12/21/2017 %31PM  File folder
[ This PC etc 5 File folder
== ¢ -
“B 3D Objects Library ile folder
obj File folder
[ Desktop . 4
= ProjectSettings File folder
B Eiantie QCAR File folder
& Downloads Temp File folder
J‘ﬁ Music UnityPackageManager File folder
[&] Pictures AR Allosaurus APK File
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‘i Local Disk (C:)
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2>
File name: | AR Allosaurus Baru )
Save as type: | apk ~

~ Hide Folders Cancel

Gambar 7.52: Menyimpan Aplikasi
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Jika muncul peringatan Android SDK is outdate, Anda bisa meng-
abaikan nya dengan pilih “Use Highhest Installed” atau memilih
“Update Android SDK” untuk menambahkan versi SDK Android
terbaru dan memerlukan koneksi internet. Tetapi jika ada error sa-
at building berarti SDK Anda perlu di Update. Kemudian Tunggu
hingga proses Build selesai.

Android 5D is outdated x

SDK Build Tools version 23.0.1 < 25.0.0,

Update Android SOK Cancel | Use Highest Installed |

Gambar 7.53: Menjalankan Aplikasi AR Rumah

Setelah proses building selesai, maka aplikasi Anda berhasil di-
buat dan salinlah .apk tersebut ke smartphone Android Anda un-
tuk dijalankan. Jangan lupa simpan projek pada Unity dengan me-
nekan tombol Ctrl+S.

Home | Share  View
= { cut
-4 -0}
B B
= =

Copy path
Finto Quick Copy Paste

B x ._Il T2 New item - i-l fyopen~  FHselectan
L] B £ Easy access = L Edit Select none
Move Copy Delete Rename  Mew Properties
fasr o 5 2

Folder £ History 5§ Invert selection

[7] Paste shorteut
Clipbaard Organize New Open Select

1 » ThisPC » LocalDisk (C:) » Users » Comet-ID » Documents » AR Allosaurus

[ Documents # 7 Name Date medified Type Size
=] Pictures . Assets 1272 M Filefolder
comet . - AM  File folder
v @ OneDrive Library M File folder
obj M File folder
R Documents ProjectSettings M File folder
& Lampiran Email QCAR File folder
&) Music Temp M File folder
& Pictures ’ File folder
G Mg I AR Allosaurus Baru I APK File 24,449 KB
) AM  APK File 21320 KB
<38 3D Objects [ AR Allosaurus.sin M SLN File 2KB
B Desktop [ s Ao isints i USERPREFS File KB
[ Documents [] Assembly-CSharp.csproj M CSPRO File 21KB
B Downlosds [7] Assembly-CSharp-Editor.csproj CSPROJ File 21 KB
b Music
&= Pictures
B Videos
5 . Local Disk(C)
= Data (DY)

Gambar 7.54: Menjalankan Aplikasi AR Rumah
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Kemudian buka File Manager pada Smartphone Anda, lalu in-
stal aplikasi “AR Allosaurus” yang telah Anda salin.

© B A Iyt

Penyimpanan... Q

@ > akar > sdcard 88

Q AR Allosaurus Baru.apk
211217 21.50 23,88 MB

AR Allosaurus.apk

21/12/17 07.04 20,82 MB

AR Rumah.apk

20/12/17 23.37 22,00 MB
;“4 _Radio_Asik_...203622.apk

VA 20121171119 23,07 MB

° _Ebbok_tes_6203501.apk
20/12/17 101 7,80 MB

7 . -
w";\a Aplikasi_Ebo...n_Bisnis.apk
ARAA 191017 2222 27,84 MB

,Ebook,ls\am...198016,@
19/12/17 11.31 17,6 MB

Gambar 7.55: File Manajer

Jika ada peringatan pembaruan pada aplikasi Anda, maka tekan
saja Pasang/install.

k1) A gl

AR Allosaurus

Anda ingin memasang pembaruan ke
aplikasi yang ada ini? Data Anda yang
ada akan hilang. Tindakan ini tidak
memerlukan akses khusus apa pun.

RATAL

Gambar 7.56: Memasang Pembaruan Aplikasi

Setelah itu arahkan kamera ke gambar/marker yang telah An-
da buat sebelumnya dan arahkan posisi yang tepat agar gaamba-
r/marker mudah terbaca. Setelah berhasil maka akan muncul mo-
del 3D Allosaurus dengan 2 objek beserta suara .
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Keluar

Gambar 7.57: Aplikasi Berhasil dijalankan

Keluar

Gambar 7.58: Allosaurus dengan Animasi Berlari

Anda juga bisa menggunakan 2 gambar marker atau lebih ter-
gantung ImageTarget yang Anda buat dalam 1 aplikasi.

Keluar

Gambar 7.59: 2 Marker dalam 1 Aplikasi
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Glossary

2D
3D

Allosaurus
API

Android

Android Studio

API

2 Dimensi. Objek yang memiliki 2
koordinat atau bidang datang

3 Dimensi. Objek yang memiliki 3
sumbu kordinat (x, y, dan z)

Salah satu jenis Dinosaurus
Application Program Interface. satu
set rutin, protokol, dan alat untuk
membangun aplikasi perangkat
lunak

Sistem operasi untuk perangkat
telepon seluler, yang dikembangkan
oleh Google. Android adalah merek
dagang.

Integrated Development
Enviroment (IDE) untuk sistem
operasi Android, yang dibangun
diatas perangkat lunak JetBrains
Intelli] IDEA dan didesain khusus
untuk pengembangan Android.
Aplication Program Interface. Satu
set rutin, protokol dan alat untuk
membangun aaplikasi perangkat
lunak
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Augmented Reality

Face Tracking

GPS
IDE

JDK
JRE
Marker

Markerless
Augmented Reality

Mobile

Motion

Teknologi yang menggabungkan
benda maya dua dimensi dan
ataupun tiga dimensi ke dalam
sebuah lingkungan nyata tiga
dimensi lalu memproyeksikan
benda-benda maya tersebut dalam
waktu nyata

Teknologi yang mampu
mengidentifikasi atau
memverivikasi atau menjejak objek
wajah dari gambar digital atau
bingkai video dari sumber video
Global Positioning System
Integrated Development
Enviroment

Java Development Kit

Java Runtime Envirotment
[lustrasi hitam dan putih persegi
dengan batas hitam tebal dan latar
belakang putih.

Augmented Reality yang tidak
memerlukan Marker untuk
menampilkan elemen-elemen
digital

Aplikasi yang dibuat secara khusus
untuk berjalan pada perangkat
komunikasi bergerak seperti
smartphone, tablet, dll

Perubahan posisi objek sehubungan
dengan lingkungannya dalam
interval waktu tertentu
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PC Personal Computer atau Komputer
Personal/Pribadi
Plugin Kode software dengan fungsi

tertentu yang memungkinkan
aplikasi atau program untuk
menjalankan fitur tambahan di
aplikasi atau program tersebut

SDK Software Development Kit

SketchUp Perangkat lunak desain grafis yang
dikem- bangkan oleh Trimble

Unity Perangkat lunak yang digunakan
untuk membuat games, simulasi,
dan bangunan arsitektur. Unity
adalah merek dagang dari Unity
Technologies.

Vuforia library yang digunakan sebagai
pendu- kung adanya Augmented
Reality pada Android. Vuforia adalah
merek dagang.

Webcam Web camera. Kamera untuk
interkasi dengan dunia web.

Reboot Mengulang pembukaan atau
menjalankan aplikasi atau sistem
operasi
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Sinopsis

Augmented Reality atau dalam bahasa Indonesia disebut realitas
tambah adalah sebuah istilah dari lingkungan yang menggabungk-
an antara dunia nyata dengan dunia virtual. Augmented Reality
merupakan teknologi baru yang berkembang cepat khususnya pa-
da perangkat mobile Android. Buku merupakan media pembela-
jaran agar dapat mengetahui inforimasi, ilmu dasar, dan sebagai
pedoman dalam belajar.

Panduan dasar ini mengadaptasi teknologi Augmented Reali-
ty yang diterapkan pada perangkat mobile berbasis Android. Pan-
duan pada buku ini yaitu membuat aplikasi yang dapat menam-
pilkan animasi 3 Dimensi serta pelengkap informasi lainnya. Ter-
dapat informasi tambahan untuk memperoleh penjelasan meng-
enai materi yang terdapat pada buku ini. Aplikasi ini dibangun
dengan menggunakan software Unity, Vuforia SDK (Software De-
velopment Kit), dan beberapa software tambahan yang diperlukan
untuk membuat aplikasi Augmented Reality yang ada pada materi.

Dengan adanya Buku Augmented Reality ini diharapkan dapat
bermanfaat sebagai media pembelajaran dan mempermudah cara
membuat aplikasi Augmented Reality.
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